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CHAPTER

ONE

INTRODUCTION

1.1 Description

IMASViz is a visualization tool developed to be used within Integrated Modelling Analysis Suite (IMAS) for the
purposes of visualizing static and dynamic IMAS data, stored within IMAS Interface Data Structures (IDSs). While
the tool itself is already available for use it is still under active development, and various features, GUI improvements
etc. are still being implemented.

For additional support or if any issues are found with IMASViz please contact the developers via e-mail or submit a
ticket on JIRA ITER Webpage.

While submitting the ticket please use the options listed below

Field Required Option
Project IMAS (IMAS)
Components VIZ

Developers:

• Ludovic Fleury (CEA Cadarache, Research Institute for Magnetics fusion, e-mail: Ludovic.FLEURY@cea.fr)

• Dejan Penko (University of Ljubljana, Mech.Eng., LECAD Lab, e-mail: dejan.penko@lecad.fs.uni-lj.si)

The tool uses the following Python packages:

1. PyQt5

PyQt5 is a comprehensive set of Python bindings for Qt v5. It is implemented as more than 35 extension
modules and enables Python to be used as an alternative application development language to C++ on all
supported platforms including iOS and Android.

Qt is set of cross-platform C++ libraries that implement high-level APIs for accessing many aspects of
modern desktop and mobile systems.

For more on PyQt5 see PyQt5 webpage. For more on Qt see Qt webpage.

2. pyqtgraph

Pyqtgraph is a graphics and user interface library for Python that provides functionality commonly re-
quired in engineering and science applications. Its primary goals are a) to provide fast, interactive graph-
ics for displaying data (plots, video, etc.) and b) to provide tools to aid in rapid application development
(for example, property trees such as used in Qt Designer).

PyQtgraph makes heavy use of the Qt GUI platform (via PyQt or PySide) for its high-performance graph-
ics and numpy for heavy number crunching. In particular, pyqtgraph uses Qt’s GraphicsView framework
which is a highly capable graphics system on its own and brings optimized and simplified primitives to
this framework to allow data visualization with minimal effort.

1

https://jira.iter.org
mailto:Ludovic.FLEURY@cea.fr
mailto:dejan.penko@lecad.fs.uni-lj.si
https://pypi.org/project/PyQt5/
https://www.qt.io/


IMASViz Documentation, Release 2019

For more on pyqtgraph see pyqtgraph webpage.

3. matplotlib

Matplotlib is a Python 2D plotting library which produces publication quality figures in a variety of
hardcopy formats and interactive environments across platforms.

For more on matplotlib see matplotlib webpage.

4. sphinx

Sphinx is a tool originally created as a Python documentation generator, but it allows also generating
documentation in form of html, latex etc.

For more on Sphinx see Sphinx webpage.

IMASViz tool is available on ITER git repository (access permission is required) under project Visualization/VIZ,
branch viz2.0_develop.

Direct link to the IMASViz git.iter repository: IMASViz.

1.2 Release notes

1.2.1 Version 2.3.0

Released:

<to be released>

Changes:

• IMAS-2640: Introduced IMASViz variant of Matplotlib exporter (overwrite the faulty pyqtgraph default Mat-
plotlib exporter).

• Add Makefile for generating the IDSDef_Parser.py files instead of keeping them in the project GIT repository.

• Improve logging messages.

• IMAS-2629: Enabled creating plots for 0D signals.

• IMAS-2651: Improved the time required to build the tree view.

• IMAS-2641: Added display of sized for 2D signals.

• IMAS-2630: Fixed wrong units.

• Plot Configuration UI improvements:

– Overall UI improvement

– Replaced plot line number (marked with #) with colored plot marker.

1.2.2 Version 2.2.5

Released: 3.9.2019

Changes:

• Add support for IMAS versions 3.24.0

• Patches for the generation of IDSDef_XMLParser.py files.

• Documentation Widget fix related to ‘Contents’ component.

2 Chapter 1. Introduction
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• Optimization of the display of the node/signal contents in the Documentation Widget.

• Fixed bug when clicking twice on the root node resulted in a crash

• Additional checks while plotting added (disabled mixing plots of quantities with different units).

• Added a new command for displaying current selection as IMAS paths.

• Added time unit label for the time slider value in plots as a function of coordinate1.

1.2.3 Version 2.2.4

Released: 1.8.2019

Changes:

• Minor code improvements and fixes.

1.2.4 Version 2.2.3

Released: 30.7.2019

Changes:

• Improve customization of legend labels in the plot configuration UI.

• IMAS-2475: Fixed display of multi-line strings (e.g. ids_properties.comment).

1.2.5 Version 2.2.2

Released: 5.7.2019

Changes:

• Add support for IMAS versions 3.23.3

• Improved data handling and checks for the signal paths and occurrences.

1.2.6 Versions 2.1.0 - 2.2.1

Released: 2.7.2019

Changes:

• Add support for IMAS versions 3.22.0, 3.23.1, 3.23.2

• Improvements for the features: - Export IDS, - 1D plotting, - UDA, - plot legend labels (in case when using
UDA)

• Introduce development of standalone UI plugins (using QtDesigner) in a way that they can be also embedded
within IMASViz (HowTo documentation included)

• Addition of SOLPS plugin (suitable for reading Edge Profiles IDSs written by SOLPS-ITER)

• Patch for handling Core Profiles IDS profiled_1d array

• Work done tickets:

– IMAS-2387: Changed string on IMASviz display from ‘IMAS database name’ to ‘TOKAMAK’.

– IMAS-2404: Highlight/Enable only populated IDSs in the IMAS tree.

1.2. Release notes 3
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1.2.7 Version 2.0.0

Released: 4.2.2019

Changes:

• Full GUI migration from wxPython and wxmPlot to PyQt and pyqtgraph Python libraries (including
Equilibrium overview plugin)

• Basic plot feature performance improved greatly. Quick comparison for plotting 17 plots to a single panel using
default plotting options: - wxPython IMASViz: ~13s - PyQt5 IMASViz: less than 1s (more than 13x speed
improvement!)

• Improved tree view build performance (wxPython IMASViz was practically unable to build tree view for arrays
containing 1500+ time slices)

• Superior plot export possibilities

• GUI improvements

• Database tree browser interface display improvements

• Added first ‘node contents display’ feature (displayed in the Node Documentation Widget)

• Reduced the number of separate windows, introduce docked widgets

• Introduce first GUI icons

• MultiPlot feature relabeled to TablePlotView

• SubPlot feature relabeled to StackedPlotView

• Add support for IMAS versions 3.19.0, 3.20.0, 3.21.0 and 3.21.1

• Included documentation + manual (~60 pages in PDF) in a form of reStructuredText source files for document
generation (single source can be generated into multiple formats e.g. PDF, HMTL. . . )

• In-code documentation greatly improved and extended

• and more. . .

Short summary of files and line changes count (ignoring generated files and scripts):

• 193 commits,

• 268 files changed,

• 13316 insertions(+),

• 10162 deletions(-)

Note: The migration to PyQt5 due to IMASViz containing a large code sets is not yet fully complete. List of
known features yet to migrate to IMASViz 2.0: Add selected nodes to existing TablePlotView,
and StackedPlotView manager.

A quick GUI comparison between the previous and the new IMASViz GUI is shown below.

Overview of IMASViz 1.2 GUI:

4 Chapter 1. Introduction
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Overview of IMASViz 2.0 GUI:

1.2.8 Version 1.2

Released: 24.8.2018

Changes:

• New functionality: selection command of nodes belonging to same parent AOS (Array of Structures)

• MultiPlot and SubPlot design improvements

• Adding support for IMAS versions 3.19.0

1.2. Release notes 5
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1.2.9 Version 1.1

Released: 8.6.2018

Changes (since March 2017):

• Bugs fixes & performance improvement

• Code migration to Python3

• GUI improvements

• UDA support for visualizing remote shots data

• Reuse of plots layout (multiplots customization can be saved as a script file to be applied for any shot)

• A first plugins mechanism has been developed which allows developers to integrate their plugins to IMASViz

• The ‘Equilibrium overview plugin’ developed by Morales Jorge has been integrated into IMASViz

• Concerning UDA, WEST shots can be accessed if a SSH tunnel can be established to the remote WEST UDA
server.

• Introducing MultiPlot and SubPlot features

• Add support for IMAS version 3.18.0

6 Chapter 1. Introduction



CHAPTER

TWO

USER MANUAL

Note: The manual presented is executed on the Gateway HPC.

2.1 Getting Started

This section describes setting the environment configuration required to run the IMASViz tool and how to run the
application itself.

2.1.1 Running IMASViz as a module on The GateWay

The procedure below describes how to use IMASViz if it is available as a module on the HPC cluster.

2.1.1.1 Setting the Environment

In a new terminal, execute the following command in order to load the required modules:

module load cineca
module load imasenv # or any other specific imasenv module version
module load imas-viz/2.0.0

# The next few modules should be loaded together with imas-viz/2.0.0
# Listing them all here in case of module related issues.
# module load itm-gcc/6.1.0
# module unload itm-python/2.7
# module load itm-python/3.6
# module load itm-qt/5.8.0

Warning: IMPORTANT! IMAS databases (IDSs) were written using specific version of IMAS. In order to
open these IDSs the same IMAS module version should be used due to possible IDS database structure changes
through different versions. Any tools or utilities that work with IDSs, including IMASViz, cannot work properly
if this “IMAS version mismatch” is too great (!).

2.1.1.2 Running IMASViz

With the environment set, run the IMASviz by simply typing the following command:

7
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viz

The main GUI window of IMAS_VIZ should display, as shown in the figure below:

The description of the above input parameters is as follows:

GUI Fields Description
User name Creator/owner of the IMAS IDSs database
IMAS database
name

IMAS database label, usually device/machine name of the IMAS IDS database (i. e. iter,
aug, west. . . )

Shot number Pulse shot number
Run number Pulse run number

2.1.2 Available benchmark IMAS databases

On the GateWay HPC there are a few benchmark IMAS IDS cases available. These databases are the main source
of data used for IMASViz testing purposes and were also included in writing the this documentation. Users can freely
use them for examples and practice purposes.

Note: There IMAS IDS cases are confirmed to work with IMAS versions 3.19.1 - 3.20.0.

Available IMAS IDS Case Parameters
Parameters Case 1 Case 2 Case 3
User name g2penkod g2penkod g2penkod
IMAS database name viztest viztest viztest
Shot number 52344 52682 53223
Run number 0 0 0

2.1.3 Running IMASViz from source

The procedure below describes how to run IMASViz from source.

2.1.3.1 Requirements

The fundamental requirements in order to locally run IMASViz are:

• IMAS

• Python3 and Python libraries:

8 Chapter 2. User Manual
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– PyQt5

– pyqtgraph

– matplotlib

– Sphinx (pip3 install sphinx)

– Sphinx RTD theme (pip3 install sphinx_rtd_theme)

2.1.3.2 Obtaining the source code

To obtain the IMASViz code source the next two steps are required:

1. Clone repository from git.iter.org (permissions are required!).

Direct link to the IMASViz git.iter repository: IMASViz.

2. Switch to IMASViz2.0 branch (required if master branch is not updated yet)

git fetch # optional
git branch -r # optional
git checkout viz2.0_develop

2.1.3.3 Setting the environment

To set the environment, go to viz directory and set VIZ_HOME and VIZ_PRODUCTION environment variables by
running the next commands in the terminal:

cd viz
# bash
export VIZ_PRODUCTION=0
export VIZ_HOME=$PWD
# csh
setenv VIZ_PRODUCTION 0
setenv VIZ_HOME $PWD

Then proceed with the next instructions.

GateWay HPC

Load next modules:

module load cineca
module load imasenv
module load itm-gcc/6.1.0
module load itm-python/3.6
module load itm-qt/5.8.0

ITER HPC

Load next module:

module load IMAS/3.20.0-3.8.3

2.1. Getting Started 9
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2.1.3.4 Running IMASViz

To run IMASViz, run the next commands in terminal:

python3 $VIZ_HOME/imasviz/VizGUI/QtVIZ_GUI.py

The main GUI window of IMAS_VIZ should display, as shown in the figure below:

The description of the above input parameters is as follows:

GUI Fields Description
User name Creator/owner of the IMAS IDSs database
IMAS database
name

IMAS database label, usually device/machine name of the IMAS IDS database (i. e. iter,
aug, west. . . )

Shot number Pulse shot number
Run number Pulse run number

2.1.4 Latest documentation and manual

The documentation provided on other sources (confluence pages etc.) than the project repository might not be up to
date. To get the latest documentation, first obtain the IMASViz source code (see Obtaining the source code).

Then navigate to

cd $VIZ_HOME/doc

and run

# for PDF documentation
module load texlive
make pdflatex
xdg-open build/latex/IMASViz.pdf
# for HTML documentation
make html
firefox build/html/index.html

Note: Additional prerequisites for generating the documentation: Sphinx and Sphinx RTD theme (listed in Require-
ments)

10 Chapter 2. User Manual
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2.2 Loading IDS from IMAS local data source

This section describes and demonstrates how to load the IMAS IDS case within IMASViz and open one of the IDS
nodes.

Note: The procedure below is executed on the GateWay HPC and thus the IMAS IDS cases available on the
GateWay are used.

2.2.1 Loading IMAS IDS

The procedure to load the IDS is as follows:

• In the main IMASViz GUI, select the first tab - Local data source.

• Enter the following parameters, listed below, to the appropriate text fields.

IMAS IDS case
Parameters Values
User name g2penkod
IMAS database name viztest
Shot number 52344
Run number 0

By default, the data source is a pulse file located in $HOME/public/imasdb/<IMAS database name>/3/
0/ directory. In this case, the ~public/imasdb/viztest/3/0/ directory of user g2penkod.

The filled GUI should then look as shown in the next figure:

2.2.2 Open IDS

The procedure to open any IDS is the same. In this manual, the procedure will be shown on magnetics IDS.

1. Click Open button to open the IDS.

A navigation tree window will open, as shown in the figure below.
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2. Press the arrow button on the left side of the IDS root node.

This will expand the navigation tree window and display a list of all IDSs. The tree will allow browsing data for
the specific shot number which is displayed by the root node ( IDSs(52344) ).
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When IDS or node label is selected the Node documentation widget will display the basic information (name
and documentation) of the node, as shown below.

The Node Documentation widget can be freely taken out from the main window by clicking undock button
the and positioned anywhere on the screen. The same thing goes for the Preview Plot and Log widget.
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3. Open magnetics IDS by right-clicking on the magnetics node and selecting the command Get magnetics data
(occurrence 0) as shown in the figure below.

Note: Alternative: Double-clicking on the IDS node label -> occurrence 0 (default) of the selected IDS will
load.

The magnetics IDS nodes are displayed as new nodes in the tree, as shown in the figure below. Nodes of an IDS
are organized according to the IMAS data dictionary. Inside the magnetics tree, plottable FLT_1D nodes are
colored blue (array length > 0).
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2.3 Node selection features

IMASViz offers the user the ability to set or mark a selection of plottable arrays (nodes) as once. This way plotting
multiple plots to the same Figure or to a MultiPlot View is more convenient and faster, avoiding “one-by-one” plotting.

Note: How to plot selection is described later in section Plotting 1D arrays.

In the continuation of this section different methods of node selection are described.

2.3.1 Select One-by-one

To select nodes one by one, first, right-click on the wanted node. From the shown pop-up menu, select the command
Select <node name> .

Fig. 1: Selecting a plottable node.

The selected node label gets colored red, indicating that it is added to the selection.
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Fig. 2: Node colored red -> node is selected.

Repeat that procedure until all wanted nodes are selected.

Fig. 3: Example of multiple nodes selection.

Note: At the same time, nodes from other opened IDS databases too can be selected.

16 Chapter 2. User Manual



IMASViz Documentation, Release 2019

2.3.2 Select All Nodes of the same Structure (AOS)

To select all nodes of the same structure (same node structure type), right-click on one of the nodes and from the
shown popup-menu select the option Select All Nodes From The Same AOS .

Fig. 4: Selecting plottable nodes of the same structure/type.

All nodes of the same structure will be selected and their label will be colored to red, indicating that they were added
to the selection.
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Fig. 5: Node colored red -> node is selected. All plottable nodes of the same structure/type are selected, in this case,
17 nodes.

2.3.3 Save Node Selection Configuration

Any node selection can be saved to a configuration file and used later with any opened IMAS database. To save a
selection, follow the next steps:

1. In the main tree browser menu navigate to Node Selection -> Save Node Selection.

2. In opened GUI window type the name of the configuration.
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Fig. 6: Save Node Selection Dialog.

3. Press OK button.

Note: The configurations are saved to $HOME/.imasviz folder.

2.3.4 Apply Selection From Saved Configuration

Applying saved node selection can be performed using both Node Selection Configuration and MultiPlot Configura-
tion.

2.3.4.1 Apply Selection From Saved Node Selection Configuration

To apply selection from Node Selection Configuration, follow the next steps:

1. In the main tree browser menu navigate to Actions -> Apply Configuration. In the shown window switch to
Available Node Selection Configurations tab.

Fig. 7: Apply Node Selection Configuration tab.
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2. Select the configuration from the list.

3. Press Apply selection only.

The signal nodes, found in the configuration file, will then be selected.

2.3.4.2 Apply Selection From MultiPlot Configuration

To apply selection from MultiPlot Configuration, follow the next steps:

See also:

How the create MultiPlot Configuration is described in Table Plot View.

1. In Main Tree View Window menu navigate to Actions -> Apply Configuration. In the shown window switch
to Apply Plot Configuration tab.

Fig. 8: Apply Plot Configuration tab.

2. Select the configuration from the list.

3. Press Apply selection only.

The signal nodes, found in the configuration file, will then be selected.

2.3.5 Unselect selected Node Signals

There are few features that allow node signal unselection.

2.3.5.1 Unselect One-by-one

To unselect nodes one by one, first, right-click on the selected node. From the shown pop-up menu, select the command
Unselect <node name> .
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Fig. 9: Unselecting plottable node.

2.3.5.2 Unselect All

To unselect all selected nodes, first, right-click on the selected node. From the shown pop-up menu, select the com-
mand Unselect Nodes -> This IMAS Database or All IMAS Databases .

Fig. 10: Unselecting multiple plottable nodes at once.

2.4 Plotting 1D arrays

The plotting of 1D arrays option and plot handling is the main feature and purpose of the IMASViz.

This section describes the basics of plotting a 1D array, stored in the IDS, and how to handle the existing plots.

2.4.1 Plotting a single 1D array to plot figure

The procedure to plot 1D array is as follows:

1. Navigate through the magnetics IDS and search for the node containing FLT_1D data, for example magnet-
ics.flux_loop[0].flux.data. Plottable FLT_1D nodes are colored blue (array length > 0).
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Fig. 11: Example of plottable FLT_1D node.

By clicking on the node the preview plot will be displayed in the Preview Plot, located in the main window. This
feature helps to quickly check how the data, stored in the FLT_1D, looks when plotted.

Fig. 12: Preview Plot

2. Right-click on the magnetics.flux_loop[0].flux.data (FLT_1D) node.

3. From the pop-up menu, select the command Plot ids.magnetics.flux_loop[0].flux.data to -> figure -> New
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.

Fig. 13: Navigating through right-click menu to plot data to plot figure.

The plot should display in plot figure as shown in the image below.

Fig. 14: Basic plot figure display.

2.4.1.1 Basic plot display features

The below features are available for any plot display. Most of them are available in the right-click menu.
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Note: Term Plot Display is used for any base subwindow for displaying plots. Following that the Plot Figure contains
a single Plot Display, while Table Plot View and Stacked Plot View consist of multiple Plot Displays.

Fig. 15: Plot display window right-click menu.

View All

Zoom to view whole plot area.

Fig. 16: View All feature in the right-click menu.

24 Chapter 2. User Manual



IMASViz Documentation, Release 2019

Auto Range

Similar to View All feature with the difference that it shows plot area between values X_min -> X_max and Y_min
-> Y_max, without additional “plot margins” on the sides.

Fig. 17: Auto Range feature in the right-click menu.

Left Mouse Button Mode Change

Change between Pan Mode (move plot around) and Area Zoom Mode (choose selectable area to zoom into).

Fig. 18: Mouse Mode feature in the right-click menu.
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Fig. 19: Area Zoom example: Marking zoom area using.

Fig. 20: Area Zoom example: Result.

Axis options

X and Y axis range, inverse, mouse enable/disable options and more.
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Fig. 21: Axis Options feature in the right-click menu.

Plot Configuration and Customization

Setting color and line properties of plots shown in the Plot Display.

Fig. 22: Configure Plot feature in the right-click menu.

Each plot can be customized. By selecting this feature a separate GUI window will open, listing all plots within the
plot display window and their properties that can be customized.
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Fig. 23: Configure Plot GUI.

Fig. 24: Plot configuration example for single plot.

Plot options

Enable/Disable grid, log scale and more.
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Fig. 25: Plot Options feature in the right-click menu.

Export feature

The Plot Display scene can be exported to:

• image file (PNG, JPG, . . . ). A total of 16 image formats are supported.

• scalable vector graphics (SVG) file

• matplotlib window

• CSV file

• HDF5 file

Fig. 26: Export feature in the right-click menu.
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Fig. 27: Export GUI window.

Fig. 28: Comparison of IMASViz Plot Figure and matplotlib window

2.4.2 Adding a plot to existing figure

The procedure of adding a plot to an already existing figure is as follows:

1. From the previous navigation tree, navigate to the wanted node, for example
ids.magnetics.flux_loop[16].flux.data

2. Right-click on the node.

3. From the pop-up menu, navigate and select Plot <node name> to -> Figure -> Figure:0
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Fig. 29: Plotting to existing figure.

The plot will be added to the selected existing plot as shown in the image below.

Fig. 30: Plotting to existing figure - result.
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2.4.3 Comparing plots between two IDS databases

IMASViz allows comparing of FLT_1D arrays between two different IDS databases (different shots too). The procedure
is very similar to the one presented in the section Adding a plot to existing figure:

1. Open another IMAS database, same as shown in section Loading IDS from IMAS local data source. In this
manual this will be demonstrated using IDS with shot 52682 and run 0 parameters.

Manual IDS case
parameters values
User name g2penkod
IMAS database name viztest
Shot number 52682
Run number 0

2. Load occurrence 0 of magnetics IDS

3. Navigate through the IDS search for the wanted node, for example ids.magnetics.flux_loop[0].flux.data.

4. Right-click on the node.

5. From the pop-up menu, navigate and select Plot <node name> to -> Figure -> Figure:0

The plot will be added to the existing plot as shown in the image below.
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Fig. 31: Plotting from other IDS to existing figure - result.

2.4.4 Plotting a selection of 1D arrays to figure

The procedure of 1D arrays selection and plotting to figure is as follows:

1. In main tree view window set a selection of nodes holding 1D arrays.

Note: How to create a selection of arrays is described in section Node selection features.

2. When finished with node selection, either: - right-click on any FLT_1D node, or - click Node Selection menu
on menubar of the main tree view window.

3. From the pop-up menu, navigate and select Plot selected nodes to -> Figure -> New -> This IMAS
database .

Note: The same procedure applies plotting the selection to an existing figure.
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Fig. 32: Plotting selection to a new figure using selection from the currently opened IDS database.

Fig. 33: Example of plot figure, created by plotting data from node selection.

2.4.5 Plotting 1D array as a function of coordinate1 along the time axis

One of the IMASViz features is plotting coordinate along the time axis. This is allowed for IDS nodes, located within
time_slice[:] structure, and it is already set as a default plotting feature for such arrays.

The procedure to plot such 1D array is quite identical as in section Plotting a single 1D array to plot figure. The
procedure is described and demonstrated on equilibrium.time_slice[0].profiles_1d.phi (Torodial Flux) array.

1. Navigate through the equilibrium IDS and search for the time slice node containing FLT_1D data, for example
equilibrium.time_slice[0].profiles_1d.phi.
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Fig. 34: Example of plottable FLT_1D time slice node.

2. Right-click on the equilibrium.time_slice[0].profiles_1d.phi (FLT_1D) node.

3. From the pop-up menu, select the command Plot equilibrium.time_slice[0].profiles_1d.phi to -> figure
-> New .

Fig. 35: Navigating through right-click menu to plot data to plot figure.

The plot should display in plot figure as shown in the image below. Note that coordinate1 =
ids.equilibrium.time_slice[0].profiles_1d.psi for this FLT_1D data array.

2.4. Plotting 1D arrays 35



IMASViz Documentation, Release 2019

Fig. 36: Time slice plot figure display. The data are represented as a function
of coordinate1 (ids.equilibrium.time_slice[0].profiles_1d.psi) for the first phi time slice
(ids.equilibrium.time_slice[0].profiles_1d.phi).

The time slider allows you to move along the time axis and the plot will change accordingly.
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Fig. 37: Time slice plot figure display for ids.equilibrium.time_slice[48].profiles_1d.phi. The data are represented
as a function of coordinate1 (ids.equilibrium.time_slice[48].profiles_1d.psi).

Note: Adding a plot (presented in Adding a plot to existing figure) to such existing plot might not work as expected,
as the sliding through indexes works directly only the last added plot.

2.4.6 Plotting 1D arrays at index as a function of the time

One of the IMASViz features is plotting array values at certain index as a function of time. This is allowed for IDS
nodes, located within time_slice[:] structure, and it is already set as a default plotting feature for such arrays.

The procedure is described and demonstrated on equilibrium.time_slice[0].profiles_1d.f (Torodial Flux) array.

1. Navigate through the equilibrium IDS and search for the time slice node containing FLT_1D data, for example
equilibrium.time_slice[0].profiles_1d.f.
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Fig. 38: Example of plottable FLT_1D time slice node.

2. Right-click on the equilibrium.time_slice[0].profiles_1d.f (FLT_1D) node.

3. From the pop-up menu, select the command Plot equilibrium.time_slice[0].profiles_1d.f to -> figure ->
New .

Fig. 39: Navigating through right-click menu to plot data to plot figure.

The plot should display in plot figure as shown in the image below. Note that Y-axis values are an array of
equilibrium.time_slice[:].profiles_1d.f[0] values through all time slices (marked by [:]) and X-axis values are
time values found in equilibrium.time.
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Fig. 40: Plot as a function of time. Y-axis values are an array of equilibrium.time_slice[:].profiles_1d.f[0] values
through all time slices (marked by [:]) and X-axis values are time values found in equilibrium.time.

The time slider allows you to move along the array index and the plot will change accordingly.
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Fig. 41: Plot as a function of time. Y-axis values are an array of equilibrium.time_slice[:].profiles_1d.f[23] values
through all time slices (marked by [:]) and X-axis values are time values found in equilibrium.time node (array of
FLT_1D values).

Note: Adding a plot (presented in Adding a plot to existing figure) to such existing plot might not work as expected,
as the sliding through indexes works directly only the last added plot.

2.4.7 MultiPlot features

IMASViz provides few features that allow plotting a selection of plottable arrays to a single plot view window.

Currently there are two such features available:

• Table Plot View and

• Stacked Plot View.

Each of those Plot Views feature its own plot display layout and plot display window interaction features.
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Note: In the old IMASViz, the Table Plot View is known as MultiPlot and the Stacked Plot View is known as SubPlot.
The decision to rename those features was made due to the previous names not properly describing the feature itself
and both of those features being a form of ‘MultiPlot’ - a window consisting of multiple plot displays.

2.4.7.1 Table Plot View

Table Plot View allows the user to create a multiplot window by plotting every array from selection to its own plot
display. The plot displays are arranged to resemble a table layout, as shown in figure below.

Fig. 42: MultiPlot - Table Plot View Example.

Creating New View

To create a new Table Plot View, follow the next steps:

1. Create a selection of nodes, as described in section Plotting a selection of 1D arrays to figure.

2. When finished with node selection, either:

• right-click on any FLT_1D node or

• click Node Selection menu on menubar of the main tree view window.

3. From the pop-up menu, navigate and select Plot selected nodes to -> TablePlotView -> New -> This
IMAS database or All IMAS databases or.

2.4. Plotting 1D arrays 41



IMASViz Documentation, Release 2019

Fig. 43: Plotting selection to a new figure using selection from the currently opened IDS database.

The Table Plot View window will then be created and shown.

Note: Each plot can be customized individually by right-clicking to the plot d display and selecting option Configure
Plot.

Note: Scrolling down the Table Plot View window using the middle mouse button is disabled as the same button is
used to interact with the plot display (zoom in and out). Scrolling can be done by clicking the scroll bar on the right
and dragging it up and down.

Save MultiPlot Configuration

MultiPlot configuration (currently available only for Table Plot View feature) allows the user to save the MultiPlot
session and load it later.

To create MultiPlot configuration, follow the next steps:

1. Create a selection of nodes, as described in section Plotting a selection of 1D arrays to figure.

2. Create a Table Plot View, as described in Table Plot View.

3. In Table Plot View menubar navigate to Options -> Save Plot Configuration

Fig. 44: Save Plot Configuration Dialog Window.

4. Type configuration name in the text area.

5. Press OK.

Note: The configurations files are saved to $HOME/.imasviz folder.
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Applying MultiPlot configuration to other IMAS database

To apply MultiPlot configuration to any IMAS database, follow the next steps:

1. Open IMAS database.

2. In Main Tree View Window menu navigate to Actions -> Apply Configuration. In the shown window switch
to Apply Plot Configuration tab.

Fig. 45: Apply Plot Configuration GUI Window.

3. Select the configuration from the list.

4. Press Apply selection and plot selected data.

The Table Plot View will be created using the data stored in the configuration file.

Note: Currently this feature will take all plot data from single (currently) opened IMAS database, event though
MultiPlot configuration was made using plots from multiple IMAS databases at once. This feature is to be improved
in the future.

Warning: The plots order depends on the order in which the data selection has been performed. First selected
data will be the first plots in the Table Plot View window.

2.4.7.2 Stacked Plot View

Stacked Plot View allows the user to create a multiplot window by plotting every array from selection to its own plot
display. The plot displays are arranged to resemble a stack layout, as shown in figure below. All plots displays always
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share the same X and Y range, even when using plot interaction features such as Zoom in/out, Pan Mode, Area Zoom
Mode etc.

Fig. 46: MultiPlot - Stacked Plot View Example.

Creating New View

To create a new Stacked Plot View, follow the next steps:

1. Create a selection of nodes, as described in section Plotting a selection of 1D arrays to figure.

2. When finished with node selection, either:

• right-click on any FLT_1D node or

• click Node Selection menu on menubar of the main tree view window.

3. From the pop-up menu, navigate and select Plot selected nodes to -> StackedPlotView -> New -> This
IMAS database or All IMAS databases or.

Fig. 47: Plotting selection to a new figure using selection from the currently opened IDS database.

The Stacked Plot View window will then be shown.

Note: Each plot can be customized individually; right click on a node and select ‘Configure Plot’.
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2.5 Plugins

IMASViz allows the use of custom-made plugins which further extend the IMASViz functionality. The plugins cur-
rently available are listed here together with a manual section on how to use them.

2.5.1 Equilibrium overview plugin

This subsection describes and demonstrates the use of IMASViz equilibrium overview plugin, a simple utility for
loading and displaying multiple data from equilibrium IDS at once.

2.5.1.1 Executing the equilibrium overview plugin

The procedure of executing the IMASViz Equilibrium overview plugin is as follows:

1. In opened IMAS database navigate to the equilibrium IDS.

2. While holding the shift keyboard button, right-click on the equilibirum node. In a pop up menu a list of
available plugins for the equilibrium IDS will be displayed.

3. Click the Equilibrium overview option.

Fig. 48: Equilibrium overview plugin popup menu option.

The plugin will then first grab the data from the Equilibrium IDS which takes a few seconds. After that the plugin
window will appear.
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Fig. 49: Equilibrium overview plugin main window.

2.5.1.2 Equilibrium overview plugin GUI features

The Equilibrium plugin allows some interaction with the plots that are described below.

Plot at time slice using slider

The plotting time value can be easily set by holding and moving the slider. By doing that the red dashed line on the
left plot will move at the same time, indicating the selected time value (position).

On slider release all plots are updated for the selected time.

Plot at time slide using time value

The time can be specified directly by typing the value to the time value box.

Fig. 50: Time value box.

By pressing enter keyboard button, all plots are be updated for the specified time.
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Note: Check the left plot for the time values range.

Run through time slices

This feature allows the plugin to go through all time values and at the same time update all plots, giving a good overall
overview.

This is done by pressing the Run button.

Enable plot grid

To enable grid on all plots check the Enable Grid option.

2.5.2 SOLPS overview plugin

This subsection describes and demonstrates the use of IMASViz SOLPS overview plugin, a simple utility for loading
and displaying grid geometry (including grid subsets), and physics quantities (such as electron density, ion temperature
etc.) stored within edge_profiles IDS GGD (General Grid Description).

Note: The SOLPS overview plugin can be run also in a standalone mode (outside IMASViz) either from widget
source code or from plugin .ui source. The necessary sources can be found in directory $VIZ_HOME/imasviz/
VizPlugins/viz_solps. There, to run standalone widget run command python3 SOLPSwidget.
py in terminal. To run standalone plugin (the same one as used in IMASViz) run command python3
run_plugin_ui_standalone.py.

Note: The development procedure of the SOLPS overview plugin can be seen in a short movie found in section
Developing a custom user interface (UI) plugins with Qt designer.

2.5.2.1 Executing the SOLPS overview plugin

The procedure of executing the IMASViz SOLPS overview plugin is as follows:

1. In opened IMAS database navigate to the edge_profiles IDS.

2. While holding the shift keyboard button, right-click on the edge_profiles node. In a pop up menu a list of
available plugins for the edge_profiles IDS will be displayed.

3. Click the SOLPS overview option.

Fig. 51: SOLPS overview plugin popup menu option

After that the main plugin window will appear, containing an empty plot widget and a few buttons.
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Fig. 52: SOLPS overview plugin main window.

4. Click the Set IDS button. The plugin will then first read the available data from the Edge Profiles IDS (provided
by IMASViz) and build the tree view which takes a few seconds.

5. Click the Set Data button. After that a dialog window will appear, requesting:

• GGD Grid (Slice), specifying a grid geometry time slice. In most cases the grid geometry does not change
with time so in such cases is obsolete to ‘re-write’ it (that is also the reason why the GGD Grid (grid_ggd)
and GGD Quantities (ggd) structures are separated).

• GGD Quantities (Slice), specifying the time slice for physics quantities,

• Grid Subset, listing all available 2D grid subsets for specified GGD Grid and GGD Quantities slice.

• Grid Subset Quantity, listing all available quantities for grid subset specified by Grid Subset drop down
list.
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Fig. 53: SOLPS overview plugin dialog for setting data (basic example values are set).

Fig. 54: List of available (2D) grid subsets for current IDS.
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Fig. 55: List of available physics quantities for current IDS.

After the requested parameters are set, press the OK button.

6. Click the Plot Data button. After pressing the button the plot widget will be populated with plot created using
the specified data.
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Fig. 56: SOLPS overview plugin plot - Cells grid subset (all 2D quad elements in the domain) + electron temperature
quantity values.

2.6 Other GUI features

Other IMASViz GUI features are listed here.

2.6.1 Hide/Show Plot Window

To hide or show any of the plot windows (Figure, Table Plot View etc.), first right-click on any signal node. From the
shown pop-up menu, select the command Show/Hide and select the plot window you wish to show or hide.

Note: Shown plot windows will be hidden while hidden windows will be shown.
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Fig. 57: Show/Hide plot window.

2.6.2 Delete Plot Window

To delete any of the plot windows, first right-click on any signal node. From the shown pop-up menu, select the
command Delete and select the plot window you wish to delete or delete all plot windows of certain type (Figure,
Table Plot View etc.).

Warning: The plot window will be deleted permanently.

Fig. 58: Delete plot window.

2.6.3 Export IDS

This feature allows the user to export the opened IDSs to a separate IDS with custom parameters.

Note: Only IDSs that are currently opened and populated in the tree view window are exported using this feature.

Note: IMAS database (e.g. device or machine) must exist before trying to export IDS to it.

To export the IDSs, first navigate to the menu Actions -> Export to IDS.
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Fig. 59: Export to IDS feature in the menu bar.

A popup dialog will be shown where the IDS case parameters are set.

Fig. 60: Empty dialog of the Export to IDS feature.

The IDS case parameters are described below:

GUI Fields Description
User name Creator/owner of the IMAS IDSs database
IMAS database
name

IMAS database label, usually device/machine name of the IMAS IDS database (i. e. iter,
aug, west. . . )

Shot number Pulse shot number
Run number Pulse run number

When the case parameters are set, press the OK button to export to the specified new IDS.

Fig. 61: Export to IDS feature dialog with set parameters.

The export status gets displayed in the tree view log widget.

2.6. Other GUI features 53



IMASViz Documentation, Release 2019

Fig. 62: Export to IDS finish message.

2.7 Scripting

There are two main methods to open and browse IMAS IDS database using IMASViz. First is the standard way of
running IMASViz (as described in Getting Started) and setting the parameters in the GUI, the second is through a
script. Furthermore, some GUI actions (like node selection, plot action commands etc.) can be performed through
scripting too. This way a simple IMASViz session can be set and populated on run.

This section describes the second method: how to create and use user-made Python3 scripts that run and populate
IMASViz.

IMASViz scripting can be seen as an advanced alternative to the Apply Configuration features (described in Apply
Selection From Saved Configuration and Applying MultiPlot configuration to other IMAS database).

The procedure below can be used with either IMASViz module and IMASViz from source but the environment must
be set accordingly to the method the IMASViz is used (!) (as described in Running IMASViz as a module on The
GateWay and Running IMASViz from source).

2.7.1 Adding IMASViz Path to PYTHONPATH

Warning: Before proceeding, make sure that the environment is properly pre-set! This way also the VIZ_HOME
system variable, required in this manual section, is available.

The IMASViz home directory can be added to PYTHONPATH system variable by running in the terminal the com-
mand below (use the command that matches your shell - c-shell or bash):

Note: PYTHONPATH is a “list” of paths that tell Python where to look for sources, libraries etc.

# c-shell (csh)
setenv PYTHONPATH ${VIZ_HOME}:${PYTHONPATH}
# bash
export PYTHONPATH=${VIZ_HOME}:${PYTHONPATH}
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2.7.2 Creating A Script

This subsection will cover the basic procedure of writing a Python3 script that can be used with IMASViz. Few such
working script examples are shown in section Script examples. The same examples can be found in project GIT
repository here.

1. First, the imports are required:

• constants, functions, and methods of the Python interpreter,

• PyQt5 classes and routines, and

• IMASViz classes and routines.

# !/usr/bin/python
# A module providing a number of functions and variables that can be used to
# manipulate different parts of the Python runtime environment.
import sys
# PyQt library imports
from PyQt5.QtWidgets import QApplication
# IMASViz source imports
from imasviz.Viz_API import Viz_API
from imasviz.VizDataSource.QVizDataSourceFactory import QVizDataSourceFactory
from imasviz.VizUtils.QVizGlobalOperations import QVizGlobalOperations
from imasviz.VizGUI.VizGUICommands.VizMenusManagement.QVizSignalHandling \

import QVizSignalHandlingds.VizMenusManagement.QVizSignalHandling \
import QVizSignalHandling

2. Set object managing the PyQt GUI application’s control flow:

app = QApplication(sys.argv)

3. Check if necessary system variables are set

QVizGlobalOperations.checkEnvSettings()

4. Set Application Program Interface

api = Viz_API()

5. Set data source retriever/factory

dataSourceFactory = QVizDataSourceFactory()

6. Load IMAS database and build the data tree view

f1 = api.CreateDataTree(dataSourceFactory.create(shotNumber=52344,
runNumber=0,
userName='g2penkod',
imasDbName='viztest'))

7. Add the build data tree view (DTV) to a list (!)

f = [f1]

8. Set the list of node paths
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pathsList1 = []
for i in range(0, 5):

pathsList1.append('magnetics/flux_loop(' + str(i) + ')/flux/data')

9. Select signals corresponding to the list of node paths

api.SelectSignals(f1, pathsList1)

10. Show the data tree window

f1.show()

11. Plot selected nodes

f = [f1]
api.PlotSelectedSignalsFrom(f)

12. Plot data from the first data source (f1) to Table Plot View

QVizSignalHandling(f1.dataTreeView).onPlotToTablePlotView(all_DTV=False)

13. Plot data from the first data source (f1) to Stacked Plot View

QVizSignalHandling(f1.dataTreeView).onPlotToStackedPlotView(all_DTV=False)

14. Keep the application running

sys.exit(app.exec_())

The final script is available below.

# !/usr/bin/python
# A module providing a number of functions and variables that can be used to
# manipulate different parts of the Python runtime environment.
import sys
# PyQt library imports
from PyQt5.QtWidgets import QApplication
# IMASViz source imports
from imasviz.Viz_API import Viz_API
from imasviz.VizDataSource.QVizDataSourceFactory import QVizDataSourceFactory
from imasviz.VizUtils.QVizGlobalOperations import QVizGlobalOperations
from imasviz.VizGUI.VizGUICommands.VizMenusManagement.QVizSignalHandling \

import QVizSignalHandling

# Set object managing the PyQt GUI application's control flow and main
# settings
app = QApplication(sys.argv)

# Check if necessary system variables are set
QVizGlobalOperations.checkEnvSettings()

# Set Application Program Interface
api = Viz_API()

# Set data source retriever/factory
dataSourceFactory = QVizDataSourceFactory()

(continues on next page)
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# Load IMAS database and build the data tree view
f1 = api.CreateDataTree(dataSourceFactory.create(shotNumber=52344,

runNumber=0,
userName='g2penkod',
imasDbName='viztest'))

# Add data tree view frame to list (!)
f = [f1]

# Set the list of node paths that are to be selected
pathsList1 = []
for i in range(0, 5):

pathsList1.append('magnetics/flux_loop(' + str(i) + ')/flux/data')

# Select signal nodes corresponding to the paths in pathsList
api.SelectSignals(f1, pathsList1)

# Show the data tree view window
f1.show()

# Plot signal nodes
# Note: Data tree view does not need to be shown in order for this
# routine to work
api.PlotSelectedSignalsFrom(f)

# Plot data from the data source to Table Plot View
QVizSignalHandling(f1.dataTreeView).onPlotToTablePlotView(all_DTV=False)

# Plot data from the data source to Stacked Plot View
QVizSignalHandling(f1.dataTreeView).onPlotToStackedPlotView(all_DTV=False)

# Keep the application running
sys.exit(app.exec_())

2.7.3 Running the script

With the environment set (done in Adding IMASViz Path to PYTHONPATH) and script completed (done in Creating A
Script), the script can be run using the basic Python3 terminal command:

python3 <path_to_script>/<script_name>.py

By running this script all Data Tree Views, Plot Widgets and MultiPlot Views, previously set in the script, should show,
as shown in the figure below.
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Fig. 63: The result of running the script example: Data Tree View (DTV), Plot Widget, Table Plot View and Stacked
Plot View containing multiple plots.

2.7.4 Script examples

Few complete script examples are shown below. The same examples can be found in project GIT repository here.

2.7.4.1 Example 1

1 #!/usr/bin/python
2 """This example demonstrates the procedure of plotting multiple arrays to
3 a single plot, Table Plot View and Stacked Plot View, using IMAS IDS databases
4 located on the GateWay HPC.
5 """
6

7 # A module providing a number of functions and variables that can be used to
8 # manipulate different parts of the Python runtime environment.
9 import sys

10 # PyQt library imports
11 from PyQt5.QtWidgets import QApplication
12 # IMASViz source imports
13 from imasviz.VizUtils.QVizGlobalOperations import QVizGlobalOperations
14 from imasviz.Viz_API import Viz_API
15 from imasviz.VizDataSource.QVizDataSourceFactory import QVizDataSourceFactory
16 from imasviz.VizUtils.QVizGlobalValues import QVizGlobalValues
17

18 # Set object managing the PyQt GUI application's control flow and main
19 # settings
20 app = QApplication(sys.argv)
21

22 # Check if necessary system variables are set
23 QVizGlobalOperations.checkEnvSettings()
24

25 # Set Application Program Interface
(continues on next page)
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26 api = Viz_API()
27

28 # Set data source retriever/factory
29 dataSourceFactory = QVizDataSourceFactory()
30

31 # Load IMAS database
32 # dataSource = dataSourceFactory.create(
33 # dataSourceName=QVizGlobalValues.IMAS_NATIVE,
34 # shotNumber=54178,
35 # runNumber=0,
36 # userName='imas_public',
37 # imasDbName='west')
38

39 # Database on the GateWay HPC (comment the above dataSource code and uncomment
40 # the one below)
41 dataSource = dataSourceFactory.create(shotNumber=52344,
42 runNumber=0,
43 userName='penkod',
44 imasDbName='viztest')
45

46

47 # Build the data tree view frame
48 f = api.CreateDataTree(dataSource)
49

50 # Set the list of node paths that are to be selected
51 paths = []
52 for i in range(0,6):
53 paths.append('magnetics/flux_loop(' + str(i) + ')/flux/data')
54

55 # Change it to dictionary with paths an occurrences (!)
56 paths = {'paths' : paths,
57 'occurrences' : [0]}
58

59 # Optional: Option with single path in dictionary
60 # paths = {'paths' : 'magnetics/flux_loop(1)/flux/data'}
61 # or
62 # paths = {'paths' : ['magnetics/flux_loop(1)/flux/data']}
63

64 # Select signal nodes corresponding to the paths in paths list
65 api.SelectSignals(f, paths)
66

67 # Plot signal nodes
68 # Note: Data tree view does not need to be shown in order for this routine to
69 # work
70 api.PlotSelectedSignals(f)
71

72 # Keep the application running
73 app.exec()

2.7.4.2 Example 2

1 # !/usr/bin/python
2 """This example demonstrates the procedure of plotting multiple arrays to a
3 single plot, Table Plot View and Stacked Plot View, using IMAS IDS databases
4 located on the GateWay HPC.

(continues on next page)

2.7. Scripting 59



IMASViz Documentation, Release 2019

(continued from previous page)

5 """
6

7 # A module providing a number of functions and variables that can be used to
8 # manipulate different parts of the Python runtime environment.
9 import sys

10 # PyQt library imports
11 from PyQt5.QtWidgets import QApplication
12 # IMASViz source imports
13 from imasviz.Viz_API import Viz_API
14 from imasviz.VizDataSource.QVizDataSourceFactory import QVizDataSourceFactory
15 from imasviz.VizUtils.QVizGlobalOperations import QVizGlobalOperations
16 from imasviz.VizGUI.VizGUICommands.VizMenusManagement.QVizSignalHandling \
17 import QVizSignalHandling
18

19 # Set object managing the PyQt GUI application's control flow and main
20 # settings
21 app = QApplication(sys.argv)
22

23 # Check if necessary system variables are set
24 QVizGlobalOperations.checkEnvSettings()
25

26 # Set Application Program Interface
27 api = Viz_API()
28

29 # Set data source retriever/factory
30 dataSourceFactory = QVizDataSourceFactory()
31

32 # Load IMAS database and build the data tree view frame
33 f1 = api.CreateDataTree(dataSourceFactory.create(shotNumber=52344,
34 runNumber=0,
35 userName='g2penkod',
36 imasDbName='viztest'))
37

38 # Load IMAS database and build the data tree view frame
39 f2 = api.CreateDataTree(dataSourceFactory.create(shotNumber=52682,
40 runNumber=0,
41 userName='g2penkod',
42 imasDbName='viztest'))
43

44 # Add data tree view frames to list (!)
45 f = [f1, f2]
46 # Set the list of node paths that are to be selected
47 pathsList1 = []
48 for i in range(0, 5):
49 pathsList1.append('magnetics/flux_loop(' + str(i) + ')/flux/data')
50 pathsList2 = []
51 for i in range(0, 6):
52 pathsList2.append('magnetics/bpol_probe(' + str(i) + ')/field/data')
53

54 # Select signal nodes corresponding to the paths in paths list
55 api.SelectSignals(f1, pathsList1)
56 api.SelectSignals(f2, pathsList2)
57 # Might use also
58 # QVizSelectSignals(f1.dataTreeView, pathsList1).execute()
59 # QVizSelectSignals(f2.dataTreeView, pathsList2).execute()
60

61 # Show the data tree view window
(continues on next page)
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62 f1.show()
63 f2.show()
64

65 # Plot signal nodes
66 # Note: Data tree view does not need to be shown in order for this routine to
67 # work
68 api.PlotSelectedSignalsFrom(f)
69

70

71 # Plot data from the first data source (f1) to Table Plot View
72 QVizSignalHandling(f1.dataTreeView).onPlotToTablePlotView(all_DTV=False)
73

74 # Plot data from the first data source (f1) to Stacked Plot View
75 QVizSignalHandling(f1.dataTreeView).onPlotToStackedPlotView(all_DTV=False)
76

77 # Keep the application running
78 sys.exit(app.exec_())

2.7.4.3 Example 2b

1 #!/usr/bin/python
2 """This example demonstrates the procedure of plotting multiple arrays from
3 two IMAS IDS databases to a single plot.
4 """
5

6 # A module providing a number of functions and variables that can be used to
7 # manipulate different parts of the Python runtime environment.
8 import sys
9 # PyQt library imports

10 from PyQt5.QtWidgets import QApplication
11 # IMASViz source imports
12 from imasviz.util.GlobalOperations import GlobalOperations
13 from imasviz.Viz_API import Viz_API
14 from imasviz.VizDataSource import DataSourceFactory
15 from imasviz.VizUtils.QVizGlobalValues import QVizGlobalValues
16

17 # Set object managing the PyQt GUI application's control flow and main
18 # settings
19 app = QApplication(sys.argv)
20

21 # Check if necessary system variables are set
22 GlobalOperations.checkEnvSettings()
23

24 # Set Application Program Interface
25 api = Viz_API()
26

27 # Set data source retriever/factory
28 dataSourceFactory = DataSourceFactory()
29

30 # Set and empty list for listing data tree view frames
31 f = []
32 # Set list of shots
33 n_shot = [52702, 52703]
34

35 for i in range(0, 2):
(continues on next page)
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36 # Load IMAS databases
37 dataSource = dataSourceFactory.create(dataSourceName=QVizGlobalValues.IMAS_NATIVE,
38 shotNumber=n_shot[i],
39 runNumber=0,
40 userName='imas_public',
41 imasDbName='west')
42 # Append data tree view frame to list
43 f.append(api.CreateDataTree(dataSource))
44

45 # Set the list of node paths (for both databases) that are to be selected
46 paths1 = []
47 for i in range(1, 3):
48 paths1.append('magnetics/flux_loop(' + str(i) + ')/flux/data')
49 paths2 = []
50 for i in range(1, 3):
51 paths2.append('magnetics/bpol_probe(' + str(i) + ')/field/data')
52

53 # Select signal nodes corresponding to the paths in paths list
54 api.SelectSignals(f[0], paths1)
55 api.SelectSignals(f[1], paths2)
56 # Plot signal nodes
57 # Note: Data tree view does not need to be shown in order for this routine to
58 # work
59 api.PlotSelectedSignalsFrom(f)
60

61 # Show the data tree view window
62 f[0].show()
63 f[1].show()
64

65 # Keep the application running
66 app.exec()

2.7.4.4 Example 3

1 #!/usr/bin/python
2 """This example demonstrates the procedure of plotting multiple arrays to a
3 single Table Plot View.
4 """
5

6 # A module providing a number of functions and variables that can be used to
7 # manipulate different parts of the Python runtime environment.
8 import sys
9 # PyQt library imports

10 from PyQt5.QtWidgets import QApplication
11 # IMASViz source imports
12 from imasviz.VizUtils.QVizGlobalOperations import QVizGlobalOperations
13 from imasviz.Viz_API import Viz_API
14 from imasviz.VizDataSource.QVizDataSourceFactory import QVizDataSourceFactory
15 from imasviz.VizUtils.QVizGlobalValues import QVizGlobalValues
16

17 # Set object managing the PyQt GUI application's control flow and main
18 # settings
19 app = QApplication(sys.argv)
20

21 # Check if necessary system variables are set
(continues on next page)
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22 QVizGlobalOperations.checkEnvSettings()
23

24 # Set Application Program Interface
25 api = Viz_API()
26

27 # Set data source retriever/factory
28 dataSourceFactory = QVizDataSourceFactory()
29

30 # Load IMAS database
31 dataSource = dataSourceFactory.create(
32 dataSourceName=QVizGlobalValues.IMAS_NATIVE,
33 shotNumber=52682,
34 runNumber=0,
35 userName='imas_public',
36 imasDbName='west')
37

38 # Database on the GateWay HPC (comment the above dataSource code and uncomment
39 # the one below)
40 # dataSource = dataSourceFactory.create(shotNumber=52344,
41 # runNumber=0,
42 # userName='g2penkod',
43 # imasDbName='viztest')
44

45 # Build the data tree view frame
46 f = api.CreateDataTree(dataSource)
47

48 # Set the list of node paths that are to be selected
49 pathsList = []
50 for i in range(0, 5):
51 pathsList.append('magnetics/flux_loop(' + str(i) + ')/flux/data')
52

53 # Select signal nodes corresponding to the paths in paths list
54 api.SelectSignals(f, pathsList)
55

56 # Plot the set of signal nodes selected by the user to a new Table Plot View.
57 api.PlotSelectedSignalsInTablePlotViewFrame(f)
58

59 # Show the data tree view window
60 api.ShowDataTree(f)
61

62 # Keep the application running
63 app.exec()

2.7.4.5 Example 4

1 #!/usr/bin/python
2

3 import os
4 # A module providing a number of functions and variables that can be used to
5 # manipulate different parts of the Python runtime environment.
6 import sys
7 # PyQt library imports
8 from PyQt5.QtWidgets import QApplication
9 # IMASViz source imports

10 from imasviz.VizUtils.QVizGlobalOperations import QVizGlobalOperations
(continues on next page)
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11 from imasviz.Viz_API import Viz_API
12 from imasviz.VizDataSource.QVizDataSourceFactory import QVizDataSourceFactory
13 from imasviz.VizGUI.VizGUICommands.VizDataSelection.QVizSelectSignals import

→˓QVizSelectSignals
14 from imasviz.VizGUI.VizGUICommands.VizDataSelection.QVizUnselectAllSignals import

→˓QVizUnselectAllSignals
15 from imasviz.VizUtils.QVizGlobalValues import QVizGlobalValues
16

17 # Set object managing the PyQt GUI application's control flow and main
18 # settings
19 app = QApplication(sys.argv)
20

21 # Check if necessary system variables are set
22 QVizGlobalOperations.checkEnvSettings()
23

24 # Set Application Program Interface
25 api = Viz_API()
26

27 # Set data source retriever/factory
28 dataSourceFactory = QVizDataSourceFactory()
29

30 # Set user (get current user)
31 userName = os.environ['USER']
32

33 # Load IMAS database
34 dataSource = dataSourceFactory.create(
35 dataSourceName=QVizGlobalValues.IMAS_NATIVE,
36 shotNumber=52344,
37 runNumber=0,
38 userName='imas_public',
39 imasDbName='west')
40

41 # Database on the GateWay HPC (comment the above dataSource code and uncomment
42 # the one below)
43 # dataSource = dataSourceFactory.create(shotNumber=52344,
44 # runNumber=0,
45 # userName='g2penkod',
46 # imasDbName='viztest')
47

48 # Build the data tree view frame
49 f = api.CreateDataTree(dataSource)
50

51 # Set configuration file
52 configFilePath = os.environ['HOME'] + "/.imasviz/configuration_name.pcfg"
53

54 # Extract signal paths from the config file and add them to a list of
55 # paths
56 pathsMap = QVizGlobalOperations.getSignalsPathsFromConfigurationFile(
57 configFile=configFilePath)
58

59 # First unselect all signals (optional)
60 # QVizUnselectAllSignals(dataTreeView=f.dataTreeView).execute()
61

62 # Select the signals, defined by a path in a list of paths, in the
63 # given Data Tree View (DTV) window
64 QVizSelectSignals(dataTreeView=f.dataTreeView,
65 pathsMap=pathsMap).execute()

(continues on next page)
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66

67 # Plot the set of the signal nodes selected using plot configuration file to
68 # a new Table Plot View and apply plot configurations (colors, line width etc.)
69 api.ApplyTablePlotViewConfiguration(f, configFilePath=configFilePath)
70

71 # Keep the application running
72 app.exec()
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CHAPTER

THREE

HOWTOS

3.1 Developing a custom user interface (UI) plugins with Qt designer

Qt Designer is a tool for designing and building Qt-based graphical user interfaces. It allows the user to design cus-
tom widgets, dialogs, main windows, etc. using on-screen forms and a user-friendly simple drag-and-drop interface.
It also provides the user with a convenient ability to preview the designs to ensure they work as intended.

In general, Qt Designer mainly offers basic Qt widgets such as Push Button, Line Edit, List Widget, etc. This list of
the Qt Designer widgets can be extended by writing so-called Qt designer plugins (do not confuse with IMASViz
plugins!). Normally this is done using C++ but PyQt5 also allows you to write Qt Designer plugins in Python3
programming language.

Such designer plugin is used to pass a custom widget source code (written in Python3) to Qt Designer. This way the
widget becomes available within the Qt designer where it can be interactively moved, designed, connected to signals
and slots and more.

Note: For more information on Qt Designer and PyQt5 based plugins and widgets check this link.

In this HOWTO section it will be described how to:

1. Develop a custom PyQt5 widget

2. Pass the custom PyQt5 widget class to Qt designer as a Qt designer plugin

3. Use the custom PyQt5 widget as a Qt designer plugin within the Qt Designer

4. Design of a custom user interface (UI) plugin (which includes the custom Qt designer plugin) with Qt
designer

5. Use the UI plugin in a standalone way as a PyQt5 application

6. Use the UI plugin in IMASViz

Warning: Qt version of used PyQt5 (compiled with Qt) and Qt designer must match!

For the purposes of this HowTo section, a widget source code for the Magnetics IDS overview Plugin was developed
and it is available in the IMASViz source code (VizPlugins/viz_example). As it is mainly intended only as an example
of a plugin (including an example of the widget source code), it is referred to mainly as an Example Plugin (same
goes for source files - exampleWidget.py and exampleplugin.py, introduced later in this howTo section).

As and addition, below is a short demonstration video of SOLPS overview Plugin, showing an example of the
processes listed in points 3-6. More on this plugin (as IMASViz plugin) can be found in section Plugins.

Local Video Link.
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3.1.1 Custom PyQt5 widget creation (code development)

This section describes and demonstrates how to write a complete custom PyQt5 widget that handles data stored within
the Magnetics IDS. Later in this HowTo section, the same widget will be then used to create Magnetics IDS overview
Plugin using Qt designer.

The main final features of this custom plugin will be:

• – Opening and reading the contents a specified IDS (specified by the set case parameters)

OR

– reading the contents of an IDS which was passed to the plugin by “host” application, and

• convenient plotting of all flux_loop and poloidal field probe (AoS) signals found in the Magnetics IDS (arrays
of values).

In this case, the whole widget source code is written in Python3 file named exampleWidget.py.

The final code can be already observed and compared here: Full final code of the example PyQt5 widget.

Note: It is highly recommended to have the finished code opened on the side while going through this HowTo section
to better understand the whole code.

Note: It is recommended to have at least basic knowledge from programming (especially with Python program-
ming language) before proceeding with the widget development instructions. A complete beginner might find those
instructions a bit overwhelming.

The steps are split into the next subsections:

1. Code header

2. Import statements

3. Widget Class definition

3.1 Widget Constructor definition

3.2 Widget base “set” and “get” routines

3.3 Widget custom routines

4. PlotCanvas Class definition

4.1 PlotCanvas Constructor definition

4.2 PlotCanvas custom plotting routines

5. Running the code as the main program (standalone)

3.1.1.1 Code header

The header of the custom PyQt5 widget source code should contain the basic information about the code itself: -
the source code (.py) filename, - short description and the purpose of this script - authors name and - authors contact
(e-mail is most convenient).
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1 # Name : exampleWidget
2 #
3 # A PyQt5 widget to serve as an example of how to create custom widgets
4 # that can be used within Qt designer.
5 # This widget embeds Matplotlib canvas (plot space). It contains also
6 # defined PyQt5 slots for setting the magnetics IDS parameters and
7 # a slot (function) for executing the plot procedure,
8 # populating/filling the Matplotlib canvas.
9 #

10 # Author :
11 # Dejan Penko
12 # E-mail :
13 # dejan.penko@lecad.fs.uni-lj.si
14 #
15 #****************************************************
16 # Copyright(c) 2019- D. Penko

Documentation should be as important to a developer as all other facets of development. Every code should include
documentation (in the forms of a header, code comments, etc.). It either explains what the code does, how it operates,
how to use it etc. Documentation is an important part of software engineering.

No matter what the code contains, chances are that someday other users will try to understand and use it. Taking
that extra time to write a proper description of the contents of the code will save huge amounts of time and effort for
everybody to understand the code.

3.1.1.2 Import statements

The custom PyQt5 widget requires additional sources - modules.

The ones required in this case are:

• The common system, OS and logging modules:

18 # import module providing system-specific parameters and functions
19 import sys
20 # import module providing miscellaneous operating system interfaces
21 import os
22 # import module providing log handling
23 import logging

• PyQt5 modules:

24 # import modules providing PyQt5 parameters, functions etc.
25 from PyQt5.QtWidgets import QApplication, QWidget, QMainWindow, QVBoxLayout,

→˓QSizePolicy
26 from PyQt5.QtCore import pyqtSlot, pyqtSignal

• Matplotlib modules and setting matplotlib to use the Qt rendering:

27 # import module providing matplotlib parameters, functions etc.
28 import matplotlib
29 matplotlib.use('Qt5Agg') # Use Qt rendering
30 from matplotlib.figure import Figure
31 from matplotlib.backends.backend_qt5agg import FigureCanvasQTAgg as FigureCanvas
32 from matplotlib.backends.backend_qt5agg import NavigationToolbar2QT as

→˓NavigationToolbar

• IMAS modules:
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33 # import module providing IMAS and IDS-related parameters, functions etc.
34 import imas

3.1.1.3 Widget class

This section describes and demonstrates how to define a new widget class in Python3.

Class definition

The initial and important part of this code is the definition of a new class inheriting from the PyQt5 QWidget class.
In this case, the class is named exampleWidget.

This class will later fully define the QWidget (contents, design, functions related to the widget and more).

36 class exampleWidget(QWidget):
37 """A widget for opening magnetics IDS, extracting the flux loop or
38 poloidal probe quantities and plotting them to matplotlib figure canvas.
39 """

Note: Do not forget to describe the class - what is its purpose etc.

Here also a new PyQt signal is set, which will be needed later in code.

41 # Create a custom signal
42 idsSet = pyqtSignal(bool)

In short, the signal on its own does not perform any action. Instead, it is connected to a slot. The slot can be any
callable Python function. When the signal gets emitted the connected slot (Python function) gets called.

Note: More on signal and slots: Link

Constructor definition

In short, constructors are generally used for initiating an object. The task of constructors is to initialize the data
members of the class when an object of the class is created.

In the case of this custom widget, the constructor required two additional arguments:

• parent (can be either Qt object, later our case QMainWindow), and

• ids (an IDS object).

Both arguments are set as None (default values).

44 def __init__(self, parent=None, ids=None, *args, **kwargs):
45 """
46 Arguments:
47 parent (PyQt5 object) : Qt widget parent (e.g. QMainWindow)
48 ids (IDS object) : IDS object - optional parameter.
49 This widget does not require IDS object in
50 order to work (the default IDS parameters

(continues on next page)
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51 will be used to open the IDS).
52 However, if an IDS object is already
53 available it can be passed to the widget
54 to be used instead (for example, passing
55 the IDS object from the IMASViz to this
56 widget).
57 """

And the ids object is set with:

65 # Set IDS object
66 # Note: if not provided as an argument it will be set to None
67 self.ids = ids

Regarding the ids object, the main idea is to make our widget capable of performing in two different ways. Either:

• use IDS object passed to the widget (in which case ids != None),

• if no IDS object was passed (ids == None), open IDS and create a new ids object.

For example, in IMASViz there is at least one IDS open at the time and thus have the ids object available. Instead
of opening the IDS again, the ids object can be just passed to the custom widget as an argument and the widget can
continue to use it.

If there is no IDS object available (meaning no IDS is already being opened), an IDS must be opened thus creating
an object referring to the IDS. In the constructor we define a dictionary labeled as self.idsParameters which should
contain all IDS parameters for IDS (will be used later to open the needed IDS):

69 # Set IDS case parameters
70 # - Empty dictionary
71 self.idsParameters = {}
72 # - shot
73 self.idsParameters['shot'] = '52344'
74 # - run r
75 self.idsParameters['run'] = '0'
76 # - user
77 self.idsParameters['user'] = os.getenv('USER')
78 # - device / machine / database name
79 self.idsParameters['device'] = 'viztest'
80 # - IMAS major version (3.x.y)
81 self.idsParameters['IMAS major version'] = '3'
82 # - label of the IDS to be used
83 self.idsParameters['idsName'] = 'magnetics'

Constructor should contain also a check if the widget is being run in a desktop environment. This is mandatory as this
is a widget which deals with GUI and visualization. The code should not be run from a “terminal-only” environment
(for example ssh user@host etc.).

In this case we define a function named checkDisplay():

188 @pyqtSlot()
189 def checkDisplay(self):
190 try:
191 os.environ['DISPLAY']
192 except:
193 logging.error('No display available!')

and execute it in the constructor:
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61 # Check if display is available (display is mandatory, as this is
62 # PyQt5 widget)
63 self.checkDisplay()

Lastly, a widget layout and its contents need to be defined (plot canvas and matplotlib navigation toolbar):

Note: The PlotCanvas class definition and the definition of its routines will be done in the following sections.

85 # Set widget layout
86 self.setLayout(QVBoxLayout())
87 # Set empty matplotlib canvas
88 self.canvas = PlotCanvas(self)
89 # Set matplotlib toolbar
90 self.toolbar = NavigationToolbar(self.canvas, self)
91 # Add canvas and toolbar to widget layout
92 self.layout().addWidget(self.canvas)
93 self.layout().addWidget(self.toolbar)

Base “set” and “get” routines

For setting and getting/returning the IDS case parameters, the definition of a few set/get routines is required.

The set routines must be set as slots (@pyqtSlot). This clearly marks the function as a slot for PyQt5 and it also
increases its speed and performance when being executed as slots in PyQt5 applications.

The get routines are simple functions which return one variable value.

146 @pyqtSlot(str)
147 def setShot(self, shot):
148 self.idsParameters['shot'] = shot
149

150 def getShot(self):
151 return self.idsParameters['shot']
152

153 @pyqtSlot(str)
154 def setRun(self, run):
155 self.idsParameters['run'] = run
156

157 def getRun(self):
158 return self.idsParameters['run']
159

160 @pyqtSlot(str)
161 def setUser(self, user):
162 self.idsParameters['user'] = user
163

164 def getUser(self):
165 return self.idsParameters['user']
166

167 @pyqtSlot(str)
168 def setDevice(self, device):
169 self.idsParameters['device'] = device
170

171 def getDevice(self):
172 return self.idsParameters['device']

(continues on next page)
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173

174 @pyqtSlot(str)
175 def setIMASmVer(self, ver):
176 self.idsParameters['IMAS major version'] = ver
177

178 def getIMASmVer(self):
179 return self.idsParameters['IMAS major version']
180

181 @pyqtSlot(str)
182 def setIDSname(self, idsName):
183 self.idsParameters['idsName'] = idsName
184

185 def getIDSname(self):
186 return self.idsParameters['idsName']

Custom functions (routines)

The first “bundle” of functions deals with IDSs:

1. openIDS: for opening the IDS (using the IDS case parameters, defined with the self.idsParameters dictionary),

125 @pyqtSlot()
126 def openIDS(self):
127 """Open magnetics IDS.
128 """
129 # Open IDS
130 self.ids = imas.ids(int(self.idsParameters['shot']),
131 int(self.idsParameters['run']))
132 self.ids.open_env(self.idsParameters['user'],
133 self.idsParameters['device'],
134 self.idsParameters['IMAS major version'])
135 # Get magnetics IDS
136 self.ids.magnetics.get()

2. setIDS: for setting the IDS object (self.ids). Here also the emit signal statement is included. This way every time
this function will be called/executed, this signal will get emmited. Later in the plugin this signal will be used to initiate
the execution of certain functions on signal-emit.

138 def setIDS(self, ids):
139 self.ids = ids
140 # Emit signal indicating that the IDS object is set
141 self.idsSet.emit(False)

3. getIDS: for getting/returning the IDS object (self.ids).

143 def getIDS(self):
144 return self.ids

The second “bundle” of functions deals with executing the plotting procedures to populate the matplotlib canvas. At
this point in this tutorial, the PlotCanvas class is not yet defined. This will be done in the next HowTo section. The
functions needed are:

• plotFluxAoS: for plotting all Flux_loop signal arrays values, and

• plotBPolAoS: for plotting all poloidal field probe signal arrays values
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95 @pyqtSlot()
96 def plotFluxAoS(self):
97 """Plot Flux Loop arrays to canvas.
98 """
99

100 # IDS check
101 if self.ids == None:
102 logging.error(' IDS was not set/opened!')
103 return
104 # Canvas figure check
105 if self.canvas.figure != None:
106 self.canvas.figure.clear()
107 # Plot flux loop Aos
108 self.canvas.plotFluxAoS(self.ids)
109

110 @pyqtSlot()
111 def plotBPolAoS(self):
112 """Plot poloidal field probe arrays to canvas.
113 """
114

115 # IDS check
116 if self.ids == None:
117 logging.error(' IDS was not set/opened!')
118 return
119 # Canvas figure check
120 if self.canvas.figure != None:
121 self.canvas.figure.clear()
122 # Plot Poloidal field AoS
123 self.canvas.plotBPolAoS(self.ids)

3.1.1.4 PlotCanvas

This section describes and demonstrates how to define a new matplotlib FigureCanvas class in Python3.

Class definition

Second main part this code (with the first being the definition of the exampleWindget class) is the definition of a new
class inheriting from the matplotlib FigureCanvas class. In this case, the class is named PlotCanvas.

This class will later fully define the matplotlib plot frame (canvas) and functions related to it.

195 class PlotCanvas(FigureCanvas):
196 """Matplotlib figure canvas that is to be embedded within the widget.
197 FigureCanvas is the area onto which the figure is drawn
198 """

Constructor definition

In this case the constructor takes 4 additional arguments:

• parent (our custom QWidget),

• width (canvas width),

• height (canvas height), and
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• dpi (dots per inch).

The parent argument is set as None, width to 5, height to 5 and dpi to 100 (default values).

200 def __init__(self, parent=None, width=5, height=4, dpi=100):
201 """
202 Arguments:
203 parent (PyQt5 object) : PyQt5 parent (e.g. QWidget).
204 width (int) : Canvas width.
205 height (int) : Canvas height.
206 dpi (int) : Dots per inch.
207 """

Next, a figure object fig is set:

Note: Figure routine is taken from the import statement (see Import statements).

109

110 @pyqtSlot()
111 def plotBPolAoS(self):
112 """Plot poloidal field probe arrays to canvas.
113 """
114

115 # IDS check
116 if self.ids == None:
117 logging.error(' IDS was not set/opened!')
118 return
119 # Canvas figure check
120 if self.canvas.figure != None:
121 self.canvas.figure.clear()
122 # Plot Poloidal field AoS
123 self.canvas.plotBPolAoS(self.ids)
124

125 @pyqtSlot()
126 def openIDS(self):
127 """Open magnetics IDS.
128 """
129 # Open IDS
130 self.ids = imas.ids(int(self.idsParameters['shot']),
131 int(self.idsParameters['run']))
132 self.ids.open_env(self.idsParameters['user'],
133 self.idsParameters['device'],
134 self.idsParameters['IMAS major version'])
135 # Get magnetics IDS
136 self.ids.magnetics.get()
137

138 def setIDS(self, ids):
139 self.ids = ids
140 # Emit signal indicating that the IDS object is set
141 self.idsSet.emit(False)
142

143 def getIDS(self):
144 return self.ids
145

146 @pyqtSlot(str)
147 def setShot(self, shot):
148 self.idsParameters['shot'] = shot

(continues on next page)
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149

150 def getShot(self):
151 return self.idsParameters['shot']
152

153 @pyqtSlot(str)
154 def setRun(self, run):
155 self.idsParameters['run'] = run
156

157 def getRun(self):
158 return self.idsParameters['run']
159

160 @pyqtSlot(str)
161 def setUser(self, user):
162 self.idsParameters['user'] = user
163

164 def getUser(self):
165 return self.idsParameters['user']
166

167 @pyqtSlot(str)
168 def setDevice(self, device):
169 self.idsParameters['device'] = device
170

171 def getDevice(self):
172 return self.idsParameters['device']
173

174 @pyqtSlot(str)
175 def setIMASmVer(self, ver):
176 self.idsParameters['IMAS major version'] = ver
177

178 def getIMASmVer(self):
179 return self.idsParameters['IMAS major version']
180

181 @pyqtSlot(str)
182 def setIDSname(self, idsName):
183 self.idsParameters['idsName'] = idsName
184

185 def getIDSname(self):
186 return self.idsParameters['idsName']
187

188 @pyqtSlot()
189 def checkDisplay(self):
190 try:
191 os.environ['DISPLAY']
192 except:
193 logging.error('No display available!')
194

195 class PlotCanvas(FigureCanvas):
196 """Matplotlib figure canvas that is to be embedded within the widget.
197 FigureCanvas is the area onto which the figure is drawn
198 """
199

200 def __init__(self, parent=None, width=5, height=4, dpi=100):
201 """
202 Arguments:
203 parent (PyQt5 object) : PyQt5 parent (e.g. QWidget).
204 width (int) : Canvas width.
205 height (int) : Canvas height.

(continues on next page)

76 Chapter 3. HOWTOs



IMASViz Documentation, Release 2019

(continued from previous page)

206 dpi (int) : Dots per inch.
207 """
208

209 # Set figure
210 fig = Figure(figsize=(width, height), dpi=dpi)

Next, the (by class) inherited FigureCanvas constructor is executed. The fig object is passed to it as an argument. This
way the figure is embedded within the matplotlib canvas.

211 # Set canvas (pass figure)
212 FigureCanvas.__init__(self, fig)

Next, the parent of the FigureCanvas is set:

213 # Set canvas parent
214 self.setParent(parent)

Lastly, the FigureCanvas size policy is set.

215 # Set canvas size policy
216 FigureCanvas.setSizePolicy(self,
217 QSizePolicy.Expanding,
218 QSizePolicy.Expanding)

The whole PlotCanvas constructor code:

200 def __init__(self, parent=None, width=5, height=4, dpi=100):
201 """
202 Arguments:
203 parent (PyQt5 object) : PyQt5 parent (e.g. QWidget).
204 width (int) : Canvas width.
205 height (int) : Canvas height.
206 dpi (int) : Dots per inch.
207 """
208

209 # Set figure
210 fig = Figure(figsize=(width, height), dpi=dpi)
211 # Set canvas (pass figure)
212 FigureCanvas.__init__(self, fig)
213 # Set canvas parent
214 self.setParent(parent)
215 # Set canvas size policy
216 FigureCanvas.setSizePolicy(self,
217 QSizePolicy.Expanding,
218 QSizePolicy.Expanding)

Custom plotting functions

There are two plotting functions required:

1. plotFluxAoS, for plotting all flux_loop signal arrays, and

2. plotBPolAoS, for plotting all poloidal field probe signal arrays values.

Both are very similar, the only difference between them is which data is extracted from the IDS and used for plotting.
Because of this similarity, only the function plotFluxAoS will be described in depth.
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The function plotFluxAoS requires only one argument: the IDS object. The function must also set the provided ids
object to self.ids object.

220 def plotFluxAoS(self, ids):
221 """Plot values found in flux loops AoS.
222

223 Arguments:
224 ids (IDS object) : IDS object referring to the IDS from which the
225 data is to be extracted.
226 """
227

228 # Add/Update IDS reference to the object (figure canvas)
229 self.ids = ids
230 # IDS check
231 if self.ids == None:
232 logging.error('IDS was not set/opened!')
233 return

Next, figure subplot must be set:

234 # Set subplot
235 ax = self.figure.add_subplot(111)

Next, the time values must be extracted and assigned to time_values array. The time values will correspond to plot
X-axis, thus, for easier representation, a new array x can be defined and the same values assigned to it.

236 # Extract X-axis values (time)
237 time_values = self.ids.magnetics.time
238 x = time_values

Next, looping through all structured of the flux_loop AoS is required. Each array values (Y-axis values) need to be
extracted and then together with the previously set time values (X-axis) a new plot can be added to the matplotlib
figure. Because of the loop, this gets repeated until no more AoS arrays are left.

239 # Get the size of AoS (number of arrays)
240 num_flux_loop_AoS = len(self.ids.magnetics.flux_loop)
241 # For each array extract array values and create a plot
242 for i in range(num_flux_loop_AoS):
243 # Extract array values
244 y = self.ids.magnetics.flux_loop[i].flux.data
245 # Set plot (line) defined by X and Y values +
246 # set line as full line (-) and add legend label.
247 ax.plot(x, y, '-', label='Flux_loop[' + str(i) + ']')

Next, few additional modifications are required:

• enabling plot grid,

• setting X-axis, Y-axis label,

• setting plot title,

• enabling legend, and

• drawing the plot.

248 # Enable grid
249 ax.grid()
250 # Set axis labels and plot title

(continues on next page)
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251 ax.set(xlabel='time [s]', ylabel='Flux Loop values',
252 title='Flux loop')
253 # Enable legend
254 ax.legend()
255 # Draw/Show plots
256 self.draw()

Final plotFluxAoS code:

220 def plotFluxAoS(self, ids):
221 """Plot values found in flux loops AoS.
222

223 Arguments:
224 ids (IDS object) : IDS object referring to the IDS from which the
225 data is to be extracted.
226 """
227

228 # Add/Update IDS reference to the object (figure canvas)
229 self.ids = ids
230 # IDS check
231 if self.ids == None:
232 logging.error('IDS was not set/opened!')
233 return
234 # Set subplot
235 ax = self.figure.add_subplot(111)
236 # Extract X-axis values (time)
237 time_values = self.ids.magnetics.time
238 x = time_values
239 # Get the size of AoS (number of arrays)
240 num_flux_loop_AoS = len(self.ids.magnetics.flux_loop)
241 # For each array extract array values and create a plot
242 for i in range(num_flux_loop_AoS):
243 # Extract array values
244 y = self.ids.magnetics.flux_loop[i].flux.data
245 # Set plot (line) defined by X and Y values +
246 # set line as full line (-) and add legend label.
247 ax.plot(x, y, '-', label='Flux_loop[' + str(i) + ']')
248 # Enable grid
249 ax.grid()
250 # Set axis labels and plot title
251 ax.set(xlabel='time [s]', ylabel='Flux Loop values',
252 title='Flux loop')
253 # Enable legend
254 ax.legend()
255 # Draw/Show plots
256 self.draw()

As already stated, plotBPolAoS function code is almost identical to plotFluxAoS code.

Final plotBPolAoS:

258 def plotBPolAoS(self, ids):
259 """Plot poloidal field probe values.
260

261 Arguments:
262 ids (IDS object) : IDS object referring to the IDS from which the
263 data is to be extracted.

(continues on next page)
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264 """
265 # Add/Update IDS reference to the object (figure canvas)
266 self.ids = ids
267 # IDS check
268 if self.ids == None:
269 logging.error('IDS was not set/opened!')
270 return
271 # Set subplot
272 ax = self.figure.add_subplot(111)
273 # Extract X-axis values (time)
274 time_values = self.ids.magnetics.time
275 x = time_values
276 # Get the size of AoS (number of arrays)
277 num_bpol_probe_AoS = len(self.ids.magnetics.bpol_probe)
278 # For each array extract array values and create a plot
279 for i in range(num_bpol_probe_AoS):
280 # Extract array values
281 y = self.ids.magnetics.bpol_probe[i].field.data
282 # Set plot (line) defined by X and Y values +
283 # set line as full line (-) and add legend label.
284 ax.plot(x, y, '-', label='bpol_probe[' + str(i) + ']')
285 # Enable grid
286 ax.grid()
287 # Set axis labels and plot title
288 ax.set(xlabel='time [s]', ylabel='Poloidal field probe values',
289 title='Poloidal field probe')
290 # Enable legend
291 ax.legend()
292 # Draw/Show plots
293 self.draw()

At this point the exampleWidget.py code is finished and ready for use.

3.1.1.5 Running the code as the main program (standalone)

To run this example widget in a standalone way, few more lines must be added to the exampleWidget.py.

This part of the code contains setting the QApplication, QMainWindow, initiating the exampleWidget class, reading
the IDS (parameters are set in the exampleWidget constructor) and executing the plotting procedures.

295 if __name__ == '__main__':
296

297 # Set application object
298 app = QApplication(sys.argv)
299 # Set main PyQt5 window
300 mainWindow = QMainWindow()
301 # Set window title
302 mainWindow.setWindowTitle('Example Widget')
303 # Set example widget object
304 ew = exampleWidget()
305 # Open IDS (magnetics IDS)
306 ew.openIDS()
307 # Plot Flux Loop arrays
308 ew.plotFluxAoS()
309 # Plot poloidal field probe arrays (an option other than plotFluxAoS)
310 # ew.plotBPolAoS()

(continues on next page)
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311 # Set example widget as a central widget of the main window
312 mainWindow.setCentralWidget(ew)
313 # Show the main window
314 mainWindow.show()
315 # Keep the application running (until the 'exit application' command is
316 # executed
317 sys.exit(app.exec_())

The code can now be run from the terminal with the next command:

python3 exampleWidget.py

Note: Make sure that the IDS with the specified case parameters exists (done in Constructor definition using idsPa-
rameters dictionary)!

Fig. 1: exampleWidget.py: Plotting all magnetics IDS arrays (17) of AoS flux_loop found in IDS (on GateWay
HPC) shot: 52344; run: 0; user: g2penkod; device: viztest.
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Fig. 2: exampleWidget.py: Plotting all magnetics IDS arrays (ABOUT 130) of AoS bpol_probe found in IDS (on
GateWay HPC) shot: 52344; run: 0; user: g2penkod; device: viztest.

3.1.1.6 Full final code of the example PyQt5 widget

1 # Name : exampleWidget
2 #
3 # A PyQt5 widget to serve as an example of how to create custom widgets
4 # that can be used within Qt designer.
5 # This widget embeds Matplotlib canvas (plot space). It contains also
6 # defined PyQt5 slots for setting the magnetics IDS parameters and
7 # a slot (function) for executing the plot procedure,
8 # populating/filling the Matplotlib canvas.
9 #

10 # Author :
11 # Dejan Penko
12 # E-mail :
13 # dejan.penko@lecad.fs.uni-lj.si
14 #
15 #****************************************************
16 # Copyright(c) 2019- D. Penko
17

18 # import module providing system-specific parameters and functions

(continues on next page)
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19 import sys
20 # import module providing miscellaneous operating system interfaces
21 import os
22 # import module providing log handling
23 import logging
24 # import modules providing PyQt5 parameters, functions etc.
25 from PyQt5.QtWidgets import QApplication, QWidget, QMainWindow, QVBoxLayout,

→˓QSizePolicy
26 from PyQt5.QtCore import pyqtSlot, pyqtSignal
27 # import module providing matplotlib parameters, functions etc.
28 import matplotlib
29 matplotlib.use('Qt5Agg') # Use Qt rendering
30 from matplotlib.figure import Figure
31 from matplotlib.backends.backend_qt5agg import FigureCanvasQTAgg as FigureCanvas
32 from matplotlib.backends.backend_qt5agg import NavigationToolbar2QT as

→˓NavigationToolbar
33 # import module providing IMAS and IDS-related parameters, functions etc.
34 import imas
35

36 class exampleWidget(QWidget):
37 """A widget for opening magnetics IDS, extracting the flux loop or
38 poloidal probe quantities and plotting them to matplotlib figure canvas.
39 """
40

41 # Create a custom signal
42 idsSet = pyqtSignal(bool)
43

44 def __init__(self, parent=None, ids=None, *args, **kwargs):
45 """
46 Arguments:
47 parent (PyQt5 object) : Qt widget parent (e.g. QMainWindow)
48 ids (IDS object) : IDS object - optional parameter.
49 This widget does not require IDS object in
50 order to work (the default IDS parameters
51 will be used to open the IDS).
52 However, if an IDS object is already
53 available it can be passed to the widget
54 to be used instead (for example, passing
55 the IDS object from the IMASViz to this
56 widget).
57 """
58 # Run QWidget constructor
59 super(QWidget, self).__init__(parent)
60

61 # Check if display is available (display is mandatory, as this is
62 # PyQt5 widget)
63 self.checkDisplay()
64

65 # Set IDS object
66 # Note: if not provided as an argument it will be set to None
67 self.ids = ids
68

69 # Set IDS case parameters
70 # - Empty dictionary
71 self.idsParameters = {}
72 # - shot
73 self.idsParameters['shot'] = '52344'

(continues on next page)
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74 # - run r
75 self.idsParameters['run'] = '0'
76 # - user
77 self.idsParameters['user'] = os.getenv('USER')
78 # - device / machine / database name
79 self.idsParameters['device'] = 'viztest'
80 # - IMAS major version (3.x.y)
81 self.idsParameters['IMAS major version'] = '3'
82 # - label of the IDS to be used
83 self.idsParameters['idsName'] = 'magnetics'
84

85 # Set widget layout
86 self.setLayout(QVBoxLayout())
87 # Set empty matplotlib canvas
88 self.canvas = PlotCanvas(self)
89 # Set matplotlib toolbar
90 self.toolbar = NavigationToolbar(self.canvas, self)
91 # Add canvas and toolbar to widget layout
92 self.layout().addWidget(self.canvas)
93 self.layout().addWidget(self.toolbar)
94

95 @pyqtSlot()
96 def plotFluxAoS(self):
97 """Plot Flux Loop arrays to canvas.
98 """
99

100 # IDS check
101 if self.ids == None:
102 logging.error(' IDS was not set/opened!')
103 return
104 # Canvas figure check
105 if self.canvas.figure != None:
106 self.canvas.figure.clear()
107 # Plot flux loop Aos
108 self.canvas.plotFluxAoS(self.ids)
109

110 @pyqtSlot()
111 def plotBPolAoS(self):
112 """Plot poloidal field probe arrays to canvas.
113 """
114

115 # IDS check
116 if self.ids == None:
117 logging.error(' IDS was not set/opened!')
118 return
119 # Canvas figure check
120 if self.canvas.figure != None:
121 self.canvas.figure.clear()
122 # Plot Poloidal field AoS
123 self.canvas.plotBPolAoS(self.ids)
124

125 @pyqtSlot()
126 def openIDS(self):
127 """Open magnetics IDS.
128 """
129 # Open IDS
130 self.ids = imas.ids(int(self.idsParameters['shot']),
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131 int(self.idsParameters['run']))
132 self.ids.open_env(self.idsParameters['user'],
133 self.idsParameters['device'],
134 self.idsParameters['IMAS major version'])
135 # Get magnetics IDS
136 self.ids.magnetics.get()
137

138 def setIDS(self, ids):
139 self.ids = ids
140 # Emit signal indicating that the IDS object is set
141 self.idsSet.emit(False)
142

143 def getIDS(self):
144 return self.ids
145

146 @pyqtSlot(str)
147 def setShot(self, shot):
148 self.idsParameters['shot'] = shot
149

150 def getShot(self):
151 return self.idsParameters['shot']
152

153 @pyqtSlot(str)
154 def setRun(self, run):
155 self.idsParameters['run'] = run
156

157 def getRun(self):
158 return self.idsParameters['run']
159

160 @pyqtSlot(str)
161 def setUser(self, user):
162 self.idsParameters['user'] = user
163

164 def getUser(self):
165 return self.idsParameters['user']
166

167 @pyqtSlot(str)
168 def setDevice(self, device):
169 self.idsParameters['device'] = device
170

171 def getDevice(self):
172 return self.idsParameters['device']
173

174 @pyqtSlot(str)
175 def setIMASmVer(self, ver):
176 self.idsParameters['IMAS major version'] = ver
177

178 def getIMASmVer(self):
179 return self.idsParameters['IMAS major version']
180

181 @pyqtSlot(str)
182 def setIDSname(self, idsName):
183 self.idsParameters['idsName'] = idsName
184

185 def getIDSname(self):
186 return self.idsParameters['idsName']
187

(continues on next page)

3.1. Developing a custom user interface (UI) plugins with Qt designer 85



IMASViz Documentation, Release 2019

(continued from previous page)

188 @pyqtSlot()
189 def checkDisplay(self):
190 try:
191 os.environ['DISPLAY']
192 except:
193 logging.error('No display available!')
194

195 class PlotCanvas(FigureCanvas):
196 """Matplotlib figure canvas that is to be embedded within the widget.
197 FigureCanvas is the area onto which the figure is drawn
198 """
199

200 def __init__(self, parent=None, width=5, height=4, dpi=100):
201 """
202 Arguments:
203 parent (PyQt5 object) : PyQt5 parent (e.g. QWidget).
204 width (int) : Canvas width.
205 height (int) : Canvas height.
206 dpi (int) : Dots per inch.
207 """
208

209 # Set figure
210 fig = Figure(figsize=(width, height), dpi=dpi)
211 # Set canvas (pass figure)
212 FigureCanvas.__init__(self, fig)
213 # Set canvas parent
214 self.setParent(parent)
215 # Set canvas size policy
216 FigureCanvas.setSizePolicy(self,
217 QSizePolicy.Expanding,
218 QSizePolicy.Expanding)
219

220 def plotFluxAoS(self, ids):
221 """Plot values found in flux loops AoS.
222

223 Arguments:
224 ids (IDS object) : IDS object referring to the IDS from which the
225 data is to be extracted.
226 """
227

228 # Add/Update IDS reference to the object (figure canvas)
229 self.ids = ids
230 # IDS check
231 if self.ids == None:
232 logging.error('IDS was not set/opened!')
233 return
234 # Set subplot
235 ax = self.figure.add_subplot(111)
236 # Extract X-axis values (time)
237 time_values = self.ids.magnetics.time
238 x = time_values
239 # Get the size of AoS (number of arrays)
240 num_flux_loop_AoS = len(self.ids.magnetics.flux_loop)
241 # For each array extract array values and create a plot
242 for i in range(num_flux_loop_AoS):
243 # Extract array values
244 y = self.ids.magnetics.flux_loop[i].flux.data

(continues on next page)
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245 # Set plot (line) defined by X and Y values +
246 # set line as full line (-) and add legend label.
247 ax.plot(x, y, '-', label='Flux_loop[' + str(i) + ']')
248 # Enable grid
249 ax.grid()
250 # Set axis labels and plot title
251 ax.set(xlabel='time [s]', ylabel='Flux Loop values',
252 title='Flux loop')
253 # Enable legend
254 ax.legend()
255 # Draw/Show plots
256 self.draw()
257

258 def plotBPolAoS(self, ids):
259 """Plot poloidal field probe values.
260

261 Arguments:
262 ids (IDS object) : IDS object referring to the IDS from which the
263 data is to be extracted.
264 """
265 # Add/Update IDS reference to the object (figure canvas)
266 self.ids = ids
267 # IDS check
268 if self.ids == None:
269 logging.error('IDS was not set/opened!')
270 return
271 # Set subplot
272 ax = self.figure.add_subplot(111)
273 # Extract X-axis values (time)
274 time_values = self.ids.magnetics.time
275 x = time_values
276 # Get the size of AoS (number of arrays)
277 num_bpol_probe_AoS = len(self.ids.magnetics.bpol_probe)
278 # For each array extract array values and create a plot
279 for i in range(num_bpol_probe_AoS):
280 # Extract array values
281 y = self.ids.magnetics.bpol_probe[i].field.data
282 # Set plot (line) defined by X and Y values +
283 # set line as full line (-) and add legend label.
284 ax.plot(x, y, '-', label='bpol_probe[' + str(i) + ']')
285 # Enable grid
286 ax.grid()
287 # Set axis labels and plot title
288 ax.set(xlabel='time [s]', ylabel='Poloidal field probe values',
289 title='Poloidal field probe')
290 # Enable legend
291 ax.legend()
292 # Draw/Show plots
293 self.draw()
294

295 if __name__ == '__main__':
296

297 # Set application object
298 app = QApplication(sys.argv)
299 # Set main PyQt5 window
300 mainWindow = QMainWindow()
301 # Set window title

(continues on next page)
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302 mainWindow.setWindowTitle('Example Widget')
303 # Set example widget object
304 ew = exampleWidget()
305 # Open IDS (magnetics IDS)
306 ew.openIDS()
307 # Plot Flux Loop arrays
308 ew.plotFluxAoS()
309 # Plot poloidal field probe arrays (an option other than plotFluxAoS)
310 # ew.plotBPolAoS()
311 # Set example widget as a central widget of the main window
312 mainWindow.setCentralWidget(ew)
313 # Show the main window
314 mainWindow.show()
315 # Keep the application running (until the 'exit application' command is
316 # executed
317 sys.exit(app.exec_())

3.1.2 Passing custom PyQt5 widget to Qt designer

In order to pass the custom PyQt5 widget to Qt designer, a separate Qt plugin Python file is required, written in
Python3 programming language. The name of this file is of major importance as if set improperly the Qt designer
will not recognize it! The name of this file should end with plugin.py (case sensitive!). In this case, the file is named
exampleplugin.py. it must be placed in the same directory as the widget source code - exampleWidget.py.

This plugin .py file for Qt designer follows a certain template which can be used and slightly modified as required..

The whole code is shown below.

1 #!/usr/bin/env python3
2

3 """
4

5 An example of a widget as a Qt designer plugin. The widget plots magnetics IDS
6 data.
7

8 """
9

10 from PyQt5.QtGui import QIcon, QPixmap
11 from PyQt5.QtDesigner import QPyDesignerCustomWidgetPlugin
12

13 from exampleWidget import exampleWidget
14

15 class exampleplugin(QPyDesignerCustomWidgetPlugin):
16 """Plugin for exampleWidget functionality.
17 """
18 def __init__(self, parent=None):
19 super(exampleplugin, self).__init__(parent)
20

21 def createWidget(self, parent):
22 return exampleWidget(parent=parent, ids=None)
23

24 def name(self):
25 return "exampleWidget"
26

27 def group(self):

(continues on next page)
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28 return "IMASViz"
29

30 def icon(self):
31 return QIcon(_logo_pixmap)
32

33 def toolTip(self):
34 return "Plot magnetics IDS data."
35

36 def whatsThis(self):
37 return ""
38

39 def isContainer(self):
40 return False
41

42 def domXml(self):
43 return '<widget class="exampleWidget" name="exampleWidget">\n</widget>'
44

45 def includeFile(self):
46 return "exampleWidget"
47

48 # Define the image used for the icon.
49 # Note: This is IMASviz default pixmap.
50 _logo_16x16_xpm = [
51 "16 16 3 1 ",
52 " c black",
53 ". c #0000E3",
54 "X c None",
55 "XXXXXXXXXXXXXXXX",
56 "XXXXXXXXXXXXXXXX",
57 "XXXXXXXXXXXXXXXX",
58 " XX X XX XX X",
59 " XX XX XX XX",
60 " XX X X XXX ",
61 " XX XX X XX X X",
62 "XXXXXXXXXXXXXXXX",
63 "................",
64 "XXXXXXXXXXXXXXXX",
65 "XXX XX X X XXX",
66 "XXX X XX XX XXXX",
67 "XXXX XX X XXXXX",
68 "XXXX XX X XXX",
69 "XXXXXXXXXXXXXXXX",
70 "XXXXXXXXXXXXXXXX"]
71

72 _logo_pixmap = QPixmap(_logo_16x16_xpm)

Below are listed lines of the Qt plugin code, which must be modified for any new widget, in order to properly refer to
the widget source code - in this case exampleWidget (exampleWidget.py).

1. Import statement:

13 from exampleWidget import exampleWidget

2. Class label:

15 class exampleplugin(QPyDesignerCustomWidgetPlugin):

3. Class constructor:
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18 def __init__(self, parent=None):
19 super(exampleplugin, self).__init__(parent)

4. Returning custom widget object on createWidget.

Note: If widget constructor requires arguments they must be included here! In this case parent and ids.

21 def createWidget(self, parent):
22 return exampleWidget(parent=parent, ids=None)

5. Name:

24 def name(self):
25 return "exampleWidget"

6. Group:

27 def group(self):
28 return "IMASViz"

7. Tool tip:

33 def toolTip(self):
34 return "Plot magnetics IDS data."

8. XML attribute definition:

42 def domXml(self):
43 return '<widget class="exampleWidget" name="exampleWidget">\n</widget>'

9. Include file:

45 def includeFile(self):
46 return "exampleWidget"

10. Icon - pixmap (optional):

48 # Define the image used for the icon.
49 # Note: This is IMASviz default pixmap.
50 _logo_16x16_xpm = [
51 "16 16 3 1 ",
52 " c black",
53 ". c #0000E3",
54 "X c None",
55 "XXXXXXXXXXXXXXXX",
56 "XXXXXXXXXXXXXXXX",
57 "XXXXXXXXXXXXXXXX",
58 " XX X XX XX X",
59 " XX XX XX XX",
60 " XX X X XXX ",
61 " XX XX X XX X X",
62 "XXXXXXXXXXXXXXXX",
63 "................",
64 "XXXXXXXXXXXXXXXX",
65 "XXX XX X X XXX",
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66 "XXX X XX XX XXXX",
67 "XXXX XX X XXXXX",
68 "XXXX XX X XXX",
69 "XXXXXXXXXXXXXXXX",
70 "XXXXXXXXXXXXXXXX"]
71

72 _logo_pixmap = QPixmap(_logo_16x16_xpm)

With the source and plugin code (.py files) completed they are ready to be used in Qt designer.

To achieve that, first the location of the necessary files must be provided to the Qt designer. This is done by adding a
path to the $PYQTDESIGNERPATH system environment variable.

# Bash shell
export PYQTDESIGNERPATH=/path/to/source/files:${PYQTDESIGNERPATH}
# C-shell
setenv PYQTDESIGNERPATH /path/to/source/files:${PYQTDESIGNERPATH}

in this case

# Bash shell
export PYQTDESIGNERPATH=$VIZ_HOME/imasviz/VizPlugins/viz_example:${PYQTDESIGNERPATH}
# C-shell
setenv PYQTDESIGNERPATH $VIZ_HOME/imasviz/VizPlugins/viz_example:${PYQTDESIGNERPATH}

With this step completed the PyQt5 widget, now Qt Designer plugin, is ready to be used within Qt Designer.

3.1.3 Creating a custom application/plugin with Qt Designer

In this subsection, the process of creating a custom plugin/application GUI is presented. In Qt Designer, the GUI
design and layout can be done conveniently with mouse drag-and-drop, popup-menu configurations and more.

Note: A good video presentation how to use Qt Designer is available in Developing a custom user interface (UI)
plugins with Qt designer.

The figure below presents the final look at the end of the plugin GUI design procedure.
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Fig. 3: Final design of the example plugin, indented for plotting all slices of flux loop and poloidal field data found
in magnetics IDS.

Qt designer is (usually) run with

designer-qt5

Warning: Qt version of used PyQt5 (compiled with Qt) and Qt designer must match! Qt designer with Qt
version X will not be able to find a plugin which source (widget code) was written using PyQt5 compiled with Qt
version Y!

A startup window will appear, as shown in the figure below.

3.1.3.1 GUI design procedure

1. First, a new Main Window must be created. This is done by selecting The Main Window option from the list
of templates/forms and clicking the Create button, as shown in the figure below.
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Fig. 4: Qt designer startup window.

After this is done, on the far left side of the window lays a Widget Box which displays a collection of all
available widgets. On the bottom of the list, a group IMASViz containing widget labeled exampleWidget can
be found. This is the custom widget which was developed through the first half of this manual section. The
group IMASViz was defined in the plugin.py file (def group).
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Fig. 5: Custom widget (exampleWidget) in Qt designer.

2. Next, drag and drop exampleWidget to MainWindow. The result should be similar as in the figure below.

Fig. 6: exampleWidget within MainWindow.

3. Next, drag and drop 2x Group Box and 2x vertical spacer.
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Fig. 7: Added 2x Group Box and 2x vertical spacer to MainWindow.

4. In top Group Box:

4.1. Add 5x Label, 4x LineEdit and 1x Push Button widgets.

Fig. 8: Rough Group Box design and layout.

4.2. Right click within the box and select Layout -> Lay Out in a Grid.

3.1. Developing a custom user interface (UI) plugins with Qt designer 95



IMASViz Documentation, Release 2019

Fig. 9: Grid layout in the top Group Box.

4.3. Set suitable texts to groupbox, Label and Push Button widgets. Set default values to LineEdit widgets.

Note: Top Label widget contains the next text:

Notes: \n - If disabled on start, the IDS is already available from other sources (application etc.)
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\n - Below are the default parameters for the benchmark IDS case (GateWay)

\n are required to achieve line breaks.

Fig. 10: Top Group Box with set labels and default values.

4.4. Select Group Box and change its next properties in the Property Editor found on the right side of the Qt
Designer application:

• QGroupBox -> checkable = True (check)

Fig. 11: Group Box property checkable found in the Property Editor.

• QWidget -> sizePolicy -> Horizontal policy = Minimum

• QWidget -> maximumSize -> Width = 175

• Layout -> layoutLeftMargin = 0

• Layout -> layoutTopMargin = 0

• Layout -> layoutRightMargin = 0

• Layout -> layoutBottomMargin = 0

• Layout -> layoutHorizontalSpacing = 0

• Layout -> layoutVerticalSpacing = 0

4.5. Select the top Label widget and change its next properties in the Property Editor:

• QFrame -> frameShape = StyledPanel

• QLabel -> wordwrap = True (checked)
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Note: Manually (with mouse cursor) resize the Group Box and the Label to see the whole text of the
top label.

4.6 Set next properties to all LineEdit widgets:

• QWidget -> sizePolicy -> Horizontal policy = Minimum

• QWidget -> sizePolicy -> Vertical policy = Fixed

Fig. 12: Finished top Group Box.

5. In bottom Group Box:

5.1. Add 2x Push Button widget.

Fig. 13: Bottom Group Box template.

5.2. Label the Group Box and Push Button widgets.

5.3. Right click within the box and select Layout -> Lay Out in a Grid.
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Fig. 14: Finished bottom Group Box.

6. Right click within the MainWindow and select Layout -> Lay Out in a Grid.

Fig. 15: MainWindow before setting grid layout.
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Fig. 16: MainWindow after setting grid layout.

7. Change MainWindow properties:

• QWidget -> windowTitle = Magnetics IDS Overview Plugin

8. Change exampleWidget properties:

• QObject -> objectName = mainPluginWidget

Warning: This property definition is crucial in the later sections in this HowTo manual when linking the
plugin in IMASViz.

• QWidget -> sizePolicy -> HorizontalPolicy = Expanding

• QWidget -> sizePolicy -> VerticalPolicy = Expanding

3.1.3.2 Edit signals/slots

By editing signals/slots the wanted actions such as plot execution etc. are added to the widgets.

To edit signals/slots, in menubar, navigate to Edit -> Edit Signals/Slots
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Fig. 17: Edit Signals/Slots in menubar.

Fig. 18: While in Edit Signals/Slots mode, hovering with the mouse over widgets marks them with slight red color.

Link Line Edit widgets (located in the top Group Box) signals to exampleWidget slots. This is done by clicking on
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one of the Line Edit widgets (in this case that one which holds the Shot value), holding and dragging the shown arrow
to exampleWidget, as shown in the figure below.

Next, the Configure connection editor will be shown.

102 Chapter 3. HOWTOs



IMASViz Documentation, Release 2019

Fig. 19: Configure connection editor, displaying list of available Line Edit (left) signals and available exampleWid-
get slots (right).

The slots are in this case actually functions/routines, which were defined in the exampleWidget source code (done in
section Widget class).

In this case, when editing the text in Line Edit and applying the changes (pressing enter key etc.) the changed value
must be passed to the exampleWidget. This is done by selecting the suitable signal and slot from the lists: textEdited
and setShot, and pressing the OK button.
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Fig. 20: Selection of Line Edit signal textEdited and exampleWidget slot setShot

After that, while in the Edit Signals/Slots, the start and the end point of the red arrow will indicate which signal and
slot are linked.
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Fig. 21: Red arrow indicating the sender, sender signal, receiver and slot.

The whole list of created slot/signal links is shown on the bottom right corner of the Qt Designer application.

Fig. 22: A list displaying a list of all created slot/signal lists, listing the sender, sender signal, receiver and slot for
each link.

The same as the first link, few more links are required. Below is a detailed table listing all necessary links.

For easier interpretation, the sender and receiver in the table below are marked with their text label instead of their
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object name (used in the Qt Designer list of signal/slots).

SENDER RECEIVER
Type Label/Value Signal Type Signal
Line Edit 52344 textEdited(QString) exampleWidget setShot(QString)
Line Edit 0 textEdited(QString) exampleWidget setRun(QString)
Line Edit g2penkod textEdited(QString) exampleWidget setUser(QString)
Line Edit viztest textEdited(QString) exampleWidget setDevice(QString)
Push Button Open IDS clicked() exampleWidget openIDS()
Push Button Plot flux loop clicked() exampleWidget openIDS()
Push Button Plot poloidal field clicked() exampleWidget openIDS()
exampleWidget Open IDS idsSet() Group Box (top) SetChecked(bool)

The final list of necessary signal/slot links in Qt Designer for this case is shown in the figure below.

At this point, the plugin is completed.

3.1.3.3 Qt Designer Preview

The constructed plugin can be tested with the Qt Designer Preview option, found in the Form menu.
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By pressing first the Open IDS button, waiting for a moment until the IDS data gets read, and then pressing the Plot
flux loop button, the plot panel is populated as shown in the figure below.

Warning: This specified case is done for the GateWay HPC. Make sure, that the corresponding IDS exists and
that it contains the right data!

Fig. 23: Plotting all Flux loop plots from the magnetics IDS with parameters (on GateWay HPC!) Shot: 52344, Run:
0, user: g2penkod, device: viztest.

3.1.3.4 Saving the Qt Designer form

The created Qt Designer GUI form (.ui extension) can be saved by navigating from menubar to File -> Save. The
name can be set customly, in this case it is saved as examplePlugin.ui (do not confuse it with examplePlugin.py).

Warning: IMPORTANT: the .ui file must be saved in the same directory as the source files, in this case
exampleWidget.py and examplePlugin.py.

3.1.3.5 Running the plugin .ui

The .ui plugin can be run using Python3 shell. Open Python3 shell and type the next commands:
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from PyQt5.QtWidgets import QApplication
from PyQt5 import uic
app = QApplication([])
uiObj = uic.loadUi('SOLPSplugin.ui')
uiObj.show()

A script example run_plugin_ui_standalone.py is available in the plugin directory. It is run with the fol-
lowing command:

python3 run_plugin_ui_standalone.py

3.1.4 Adding plugin to IMASViz

Warning: Before proceeding, make sure that you made the step 8. in Creating a custom application/plugin with
Qt Designer. Setting the objectName of the custom widget to mainPluginWidget is mandatory!

The main idea for integration of plugin in IMASViz is to simplify the plugin usage and to add further functionalities
to IMASViz. By running the plugin from IMASViz the IMASViz created IDS object is passed to the plugin, thus
opening and setting the IDS is not necessary (required when running the plugin as a standalone application as shown
in Running the plugin .ui).

To run the plugin from IMASViz it must be first added (registered) in IMASViz $VIZ_HOME/imasviz/
VizPlugins/VizPlugins.py source file. This is done through the next few steps:

1. Add plugin to a list of registered plugins

The RegisteredPlugins dictionary contains major plugin properties. The relevant properties for examplePlugin are
highlighted in the code block below, where:

• example_UiPlugin is a dictionary key (dictionary within RegisteredPlugins dictionary).

Warning: Mandatory: in case the plugin is created with the help of Qt Designer and .ui file is created, the key
must contain suffix _UiPlugin in order for IMASViz to recognize and use it correctly!

• UiFile dictionary key, holding full .ui filename.

• dir dictionary key, holding the path to the dictionary where the .ui filename (and other plugin sources) are
located.

• targetIDSroot dictionary key, holding target IDS label.

• targetOccurrence dictionary key, holding target IDS occurrence integer.

RegisteredPlugins = {'equilibriumcharts':'viz_equi.equilibriumcharts',
'SOLPS_UiPlugin': {

'UiFile': 'SOLPSplugin.ui',
'dir': os.environ['VIZ_HOME'] +

'/imasviz/VizPlugins/viz_solps/',
'targetIDSroot' : 'edge_profiles',
'targetOccurrence' : 0},

'example_UiPlugin': {
'UiFile': 'examplePlugin.ui',
'dir': os.environ['VIZ_HOME'] +

'/imasviz/VizPlugins/viz_example/',

(continues on next page)
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'targetIDSroot': 'magnetics',
'targetOccurrence': 0}

}

2. Add plugin configuration

Each plugin can have its own specific configuration. In the case of the examplePlugin there are no configurations
required. Still, an empty configuration must be provided, as highlighted in the code block below.

RegisteredPluginsConfiguration = {'equilibriumcharts':[{
'time_i': 31.880, \
'time_e': 32.020, \
'delta_t': 0.02, \
'shot': 50642, \
'run': 0, \
'machine': 'west_equinox', \
'user': 'imas_private'}],

'SOLPS_UiPlugin':[{}],
'example_UiPlugin':[{}]

}

3. Add necessary entries

The entries are mainly related to plugin identification and presentation in IMASViz in terms of label in pop-up menus.
The required entries are highlighted in the code blocks below.

EntriesPerSubject = {'equilibriumcharts': {'equilibrium_overview': [0],
'overview': [0]},

'ToFuPlugin': {'interferometer_overview': [0, 1],
'bolometer_overview': [2, 3],
'soft_x_rays_overview': [4, 5]},

'SOLPS_UiPlugin': {'edge_profiles_overview':[0],
'overview':[0]},

'example_UiPlugin': {'magnetics_overview': [0],
'overview': [0]}

}

AllEntries = {'equilibriumcharts': [(0, 'Equilibrium overview...')],
'ToFuPlugin': [(0, 'tofu - geom...'), (1, 'tofu - data'),

(2, 'tofu - geom...'), (3, 'tofu - data'),
(4, 'tofu - geom...'), (5, 'tofu - data')],

'SOLPS_UiPlugin': [(0, 'SOLPS overview...')],
'example_UiPlugin': [(0, 'Magnetics overview...')]
}

Now everything is ready to run the plugin from IMASViz.

3.1.5 Running the custom plugin in IMASViz

When running the IMASViz, for the means of this manual, open the IDS with the same case parameters as defined in
Edit signals/slots.

3.1. Developing a custom user interface (UI) plugins with Qt designer 109



IMASViz Documentation, Release 2019

In the tree window, navigate to magnetics. While holding shift key right click on the magnetics label and in the popup
menu select the Magnetics overview. . . option.

On selection confirm, the examplePlugin, now referred to as Magnetics IDS Overview Plugin, the plugin window is
shown.

Fig. 24: Magnetics IDS Overview Plugin on startup when run from within IMASViz.

It can be observed, that the top Group Box is disabled. This is due to our code and signal/slots, done in the plugin
development phase in previous sections. This way if IDS object (now provided by IMASViz) is already provided on
plugin startup the IDS set/open/read procedures are not required, but if needed are still functional and can be enabled
with checking the checkbox. This way the plugin can be conveniently used as standalone or within other applications.

By pressing either Plot flux loop or Plot poloidal field buttons the corresponding data, specified in the plugin code
development phase, are plotted.
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Fig. 25: Magnetics IDS Overview Plugin with plotted all Flux loop data from the magnetics IDS (parameters (on
GateWay HPC!) Shot: 52344, Run: 0, user: g2penkod, device: viztest.
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